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About these instructions
1 About these instructions
These instructions have been prepared with utmost care. They contain in-
formation and notes intended to ensure long-term and reliable operation.

Should you notice any discrepancies or if you have improvement requests, 
then we would be glad to receive your feedback through Customer 
Service ( p. 119).

Consider the instructions part of the product and store them in a place 
where they are readily available. 

1.1 For whom are these instructions intended?
These instructions are intended for:

• Operators:
This group is familiar with the machine and has access to the 
instructions. Specifically, chapter Operation ( p. 15) is important 
for the operators.

• Specialists:
This group has the appropriate technical training for performing 
maintenance or repairing malfunctions. Specifically, the chapter 
Setup ( p. 101) is important for specialists. (Delete this sentence 
in Service Instructions)

Service Instructions are supplied separately.

With regard to minimum qualification and other requirements to be met by 
personnel, please also follow the chapter Safety ( p. 9).

1.2 Representation conventions – symbols and characters
Various information in these instructions is represented or highlighted by the 
following characters in order to facilitate easy and quick understanding:

Proper setting
Specifies proper setting.

Disturbances
Specifies the disturbances that can occur from an incorrect setting.

Cover
Specifies which covers must be disassembled in order to access the com-
ponents to be set.
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About these instructions
Steps to be performed when operating the machine (sewing and 
equipping)

Steps to be performed for service, maintenance, and installation

Steps to be performed via the software control panel

The individual steps are numbered:
First step

Second step

The steps must always be followed in the specified order.

Lists are marked by bullet points.

Result of performing an operation
Change to the machine or on the display/control panel.

Important
Special attention must be paid to this point when performing a step.

Information
Additional information, e.g. on alternative operating options.

Order
Specifies the work to be performed before or after a setting.

References
 Reference to another section in these instructions.

Safety Important warnings for the user of the machine are specifically marked. 
Since safety is of particular importance, hazard symbols, levels of danger 
and their signal words are described separately in the chapter Safety 
( p. 9).

Location
information

If no other clear location information is used in a figure, indications of right 
or left are always from the user's point of view.

1.

2.

…

•


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About these instructions
1.3 Other documents
The machine includes components from other manufacturers. Each man-
ufacturer has performed a hazard assessment for these purchased parts 
and confirmed their design compliance with applicable European and na-
tional regulations. The proper use of the built-in components is described 
in the corresponding manufacturer's instructions.

1.4 Liability
All information and notes in these instructions have been compiled in 
accordance with the latest technology and the applicable standards and 
regulations.

Dürkopp Adler cannot be held liable for any damage resulting from:

• Breakage and damage during transport
• Failure to observe these instructions
• Improper use
• Unauthorized modifications to the machine
• Use of untrained personnel
• Use of unapproved parts

Transport
Dürkopp Adler cannot be held liable for breakage and transport damages. 
Inspect the delivery immediately upon receiving it. Report any damage to 
the last transport manager. This also applies if the packaging is not 
damaged.

Leave machines, equipment and packaging material in the condition in 
which they were found when the damage was discovered. This will ensure 
any claims against the transport company.

Report all other complaints to Dürkopp Adler immediately after receiving 
the product.
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Safety
2 Safety
This chapter contains basic information for your safety. Read the instruc-
tions carefully before setting up or operating the machine. Make sure to 
follow the information included in the safety instructions. Failure to do so 
can result in serious injury and property damage.

2.1 Basic safety instructions
The machine may only be used as described in these instructions.

These instructions must be available at the machine's location at all times.

Work on live components and equipment is prohibited. Exceptions are de-
fined in the DIN VDE 0105.

For the following work, switch off the machine at the main switch or dis-
connect the power plug:

• Replacing the needle or other sewing tools
• Leaving the workstation
• Performing maintenance work and repairs
• Threading

Missing or faulty parts could impair safety and damage the machine. 
Only use original parts from the manufacturer.

Transport Use a lifting carriage or forklift to transport the machine. Raise the ma-
chine max. 20 mm and secure it to prevent it from slipping off.

Setup The connecting cable must have a power plug approved in the relevant 
country. The power plug may only be assembled to the power cable by 
qualified specialists.

Obligations
of the operator

Follow the country-specific safety and accident prevention regulations and 
the legal regulations concerning industrial safety and the protection of the 
environment.

All the warnings and safety signs on the machine must always be in legible 
condition. Do not remove! 
Missing or damaged warnings and safety signs must be replaced 
immediately.

Requirements
to be met by

the personnel

Only qualified specialists may:

• set up the machine
• perform maintenance work and repairs
• perform work on electrical equipment

Only authorized persons may work on the machine and must first have un-
derstood these instructions.
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Safety
Operation Check the machine during operating for any externally visible damage. 
Stop working if you notice any changes to the machine. Report any chang-
es to your supervisor. Do not use a damaged machine any further.

Safety
equipment

Safety equipment should not be removed or deactivated. If it is essential 
to remove or deactivate safety equipment for a repair operation, it must be 
assembled and put back into operation immediately afterward.

2.2 Signal words and symbols used in warnings
Warnings in the text are distinguished by color bars. The color scheme 
based on the severity of the danger. Signal words indicate the severity of 
the danger.

Signal words Signal words and the hazard they describe:

Symbols The following symbols indicate the type of danger to personnel:

Signal word Meaning

DANGER (with hazard symbol)
If ignored, fatal or serious injury will result

WARNING (with hazard symbol)
If ignored, fatal or serious injury can result

CAUTION (with hazard symbol)
If ignored, moderate or minor injury can result

Caution (with hazard symbol)
If ignored, environmental damage can result

NOTICE (without hazard symbol)
If ignored, property damage can result

Symbol Type of danger

General

Electric shock
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Safety
Examples Examples of the layout of warnings in the text:

 This is what a warning looks like for a hazard that will result in serious 
injury or even death if ignored.

 This is what a warning looks like for a hazard that could result in seri-
ous or even fatal injury if ignored.

 This is what a warning looks like for a hazard that could result in 
moderate or minor injury if the warning is ignored.

Puncture

Crushing

Environmental damage

Symbol Type of danger

DANGER
Type and source of danger!
Consequences of non-compliance.

Measures for avoiding the danger.

WARNING
Type and source of danger!
Consequences of non-compliance.

Measures for avoiding the danger.

CAUTION
Type and source of danger!
Consequences of non-compliance.

Measures for avoiding the danger.
Operating Instructions 911-211 - 05.0 - 08/2019 11



Safety
 This is what a warning looks like for a hazard that could result in envi-
ronmental damage if ignored.

 This is what a warning looks like for a hazard that could result in 
property damage if ignored.

CAUTION
Type and source of danger!
Consequences of non-compliance.

Measures for avoiding the danger.

NOTICE

Type and source of danger!
Consequences of non-compliance.

Measures for avoiding the danger.
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Machine description
3 Machine description

3.1 Components of the machine

Fig. 1: Complete overview

3.2 Proper use
The machine may only be used with sewing material that satisfies the 
requirements of the specific application at hand.

The machine is intended only for use with dry sewing material. The sewing 
material must not contain any hard objects.

The needle thicknesses permissible for the machine are listed in the 
Technical Data ( p. 127) chapter.

The seam must be completed with a thread that satisfies the requirements 
of the specific application at hand.

The machine is intended for industrial use.

(1) - Reel stand
(2) - Machine head
(3) - Quick-stop
(4) - Tabletop
(5) - Tabletop height adjustment

  (6) - Stand
  (7) - Pedal
  (8) - Compressed air maintenance unit
  (9) - Main switch
(10) - Operating terminal

⑨

⑦

⑩

⑧

①

④

②

⑤

③

⑥
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Machine description
The machine may only be set up and operated in dry conditions on well-
maintained premises. If the machine is operated on premises that are not 
dry and well-maintained, then further measures may be required which 
must be compatible with DIN EN 60204-31. 

Only authorized persons may work on the machine.

Dürkopp Adler cannot be held liable for damages resulting from improper 
use.

3.3 Declaration of Conformity
The machine complies with European regulations ensuring health, safety, 
and environmental protection as specified in the declaration of conformity 
or in the declaration of incorporation.

WARNING
Risk of injury from live, moving and cutting 
parts as well as from sharp parts!
Improper use can result in electric shock, crushing, 
cutting and punctures.

Follow all instructions provided.

NOTICE

Non-observance will lead to property damage!
Improper use can result in material damage at the machine.

Follow all instructions provided.
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Operation
4 Operation

4.1 Switching on and off the machine

Fig. 2: Switching on and off the machine

Switching on the machine
To switch on the machine:

1. Turn the main switch (1) to the right into the I position.
 The following message appears on the display: 

Pedal zum Referenzieren zurücktreten (Press pedal 
for referencing)

2. Press the pedal to perform referencing of the machine.
 The main menu appears on the display.

Switching off the machine
To switch off the machine:

1. Turn the main switch (1) to the left into the 0 position.
 All drives and the control are immediately disconnected from the 

mains grid.

(1) - Main switch

①
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Operation
4.2 Switching on threading mode

Fig. 3: witching on threading mode

Switching on threading mode
To switch on threading mode:

1. Press the button (1).
Important 

The button must engage.

 The machine is in threading mode.
The sewing foot is moved to the lower position.
The lamp next to the button lights up.
The area around the hook cover (2) is lit up. 

Switching off threading mode
To switch off threading mode:

1. Press the button (1) again. 
Important

The button must disengage.

WARNING
Risk of injury from sharp and moving parts!
Puncture or crushing possible.

Prior to any maintenance or cleaning work, switch 
off the machine or set the machine to threading 
mode.
When threading mode is active, do not reach into 
the hook area until the cloth pressure bar has 
moved down.

(1) - Button for threading mode (2) - Hook cover

①

②

16 Operating Instructions 911-211 - 05.0 - 08/2019



Operation
4.3 Switching on Quick-stop
The Quick-stop switch (1) can be used to immediately stop all working 
steps on the machine, e.g. after an operating mistake.

Fig. 4: Switching on Quick-stop

To switch on Quick-stop:

1. Press the Quick-stop (1) button.
 All working steps on the machine are stopped.

Switching off the machine
1. Turn the main switch (2) to the left into the 0 position.
 All drives and the control are disconnected from the mains grid.

WARNING
Risk of injury from sharp and moving parts!
Puncture or crushing possible.

After a Quick-stop, power is still present in the 
machine, and the clamps can move.
Switch off the machine prior to maintenance or 
cleaning work

(1) - Button Quick-stop (2) - Main switch

②

①
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Operation
4.4 Swiveling the machine head up and down
The machine head can be swiveled up for maintenance work.

4.4.1 Swiveling up the machine head
Important
The drive carriage (2) must be at the rear.

Fig. 5: Swiveling up the machine head (1)

WARNING
Risk of injury from sharp and moving parts!
Puncture or crushing possible.

Switch off the machine before swiveling up the 
machine head and performing maintenance.

(1) - Head cover (2) - Drive carriage

①

②
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Operation
Fig. 6: Swiveling up the machine head (2)

To swivel up the machine head:

1. Release the locking lever (3) under the table top.
2. Lift the machine head in the head cover area (1) and swivel up carefully.
 The latch (4) latches into place.

The space under the machine table is now accessible.

(3) - Locking lever (4) - Latch

③ ④
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Operation
4.4.2 Swiveling down the machine head

Fig. 7: Swiveling down the machine head

To swivel down the machine head:

1. Hold the machine head in the head cover area.
2. Release the latch (2).
3. Swivel down the machine head carefully.
4. Latch the locking lever (1) under the table top.

WARNING
Risk of injury from moving parts!
Crushing possible.

When swiveling down the machine head, hold the 
machine head firmly in place until it has returned to 
its position.

NOTICE

Property damage may occur!
Risk of machine damage from falling machine head.

When swiveling down the machine head, hold the machine head 
firmly in place until it has returned to its position.

(1) - Locking lever (2) - Latch

① ②
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Operation
4.5 Changing the needle

Fig. 8: Changing the needle

To change the needle:

1. Push the hand crank (1) down and rotate it to the left until the needle 
bar (6) reaches the highest position.

2. Loosen the threaded pin (4).
3. Pull the needle downwards out of the needle bar (6).
4. To change from needle system 328 to 794 or 7x23: Undo the 

setscrew (5) and take off the cylinder pin (2).
To change from 794 or 7x23 to 328, insert cylinder pin (2) into the hole 
and tighten setscrew (5).

WARNING
Risk of injury from sharp parts!
Punctures possible.

Switch off the machine before you change the 
needle.

NOTICE

Property damage may occur!
Risk of damage to machine and thread if hook distance is incorrect.

When switching to a different needle thickness, adjust the distance 
between hook and needle.

(1) - Hand crank
(2) - Cylinder pin
(3) - Groove

(4) - Threaded pin
(5) - Threaded pin
(6) - Needle bar

①

③

④

⑤
⑥

②
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Operation
5. Insert the new needle into the needle bar (6) until it reaches the end 
stop.

Important
The groove (3) must face toward the hook.

6. Tighten setscrew (4) or (4) and (5)

Order
After switching to a different needle thickness, adjust the distance 
between hook and needle ( Service Instructions).

Disturbances if hook distance is incorrect

After inserting a thinner needle
• Missing stitches
• Thread damage

After inserting a thicker needle
• Damage to the hook tip
• Damage to the needle

4.6 Threading the needle thread

WARNING
Risk of injury from sharp and moving parts!
Puncture or crushing possible.

Switch off the machine before threading the needle 
thread.
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Operation
Fig. 9: Threading the needle thread (1)

To thread the needle thread:

1. Place the thread reel on the thread reel holder and guide the needle 
thread through the hole in the guide on the unwinding bracket.

Important
The unwinding bracket must be parallel to the thread stand.

2. Use compressed air to blow the thread through the hose guide (17).
3. Insert the thread through the guide (16).
4. Feed the thread counterclockwise around the tensioner (15).
5. Feed the thread clockwise around the tensioner (14).
6. Insert the thread through the guides (13) and (12).

(1) - Thread lever
(2) - Needle thread regulator
(3) - Guide
(4) - Guide
(5) - Needle thread regulator
(6) - Needle thread clamp (optional)
(7) - Guide
(8) - Guide
(9) - Needle eye

(10) - Thread tensioning spring
(11) - Diverter
(12) - Guide
(13) - Guide
(14) - Voltage
(15) - Voltage
(16) - Guide
(17) - Hose guide

①

④
⑤

⑥

⑦
⑧
⑨

⑩

⑪

⑫

⑬
⑭
⑮

⑯

⑰

③

②

Operating Instructions 911-211 - 05.0 - 08/2019 23



Operation
7. Feed the thread clockwise around the diverter (11).
8. Feed the thread under the thread tensioning spring (10), through the 

guide (3) and through the needle thread regulator (2) to the thread 
lever (1).

9. Feed the thread through the thread lever (1) and the guide (4).
10. Insert the thread through the needle thread monitor (5) and, on a 

machine with a thread cutter, through the thread clamp (6).
11. Insert the thread through the guides (7) and (8).
12. Insert the thread through the needle eye (9) in such a way that the 

loose thread end faces the hook.

Information
When using thicker threads (e.g. while sewing belts or airbags), you may 
experience that the thread wobbles. In this case, we recommend that you 
increase the wrap angle relative to the thread tension.

Thread the thread as shown below:

Fig. 10: Threading the needle thread (2)
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Operation
Needle thread threading on machines with a thread burner

Fig. 11: Needle thread threading on machines with a thread burner

13. For machines with a thread burner: Position the thread in the suction 
opening (17).

14. Press the button for the suction device (16).

NOTICE

Property damage may occur!
If the thread was not positioned in the suction opening, disturbances 
and damage may occur in the area of the hook.
It is even possible that the clutch may disengage, which may neces-
sitate more extensive repairs.
ALWAYS position the needle thread in the suction opening.

(18) - Button for suction device (19) - Suction opening

⑯

⑰

Operating Instructions 911-211 - 05.0 - 08/2019 25



Operation
4.7 Setting the needle thread regulator
The needle thread regulator determines the needle thread quantity to be 
guided around the hook. The required thread quantity depends on the 
thickness of the material to be sewn, thread strength, and stitch length.

Larger thread quantity for
• thick sewing material
• high thread strengths
• large stitch lengths 

Lower thread quantity for
• thin sewing material
• low thread strengths
• small stitch lengths

Proper setting
The loop of the needle thread slides at low tension over the thickest point 
of the hook. The largest amount of thread is required, and the thread ten-
sioning spring (1) should be pulled approx. 0.5 mm out of the lower end 
position.

Fig. 12: Setting the needle thread regulator

To set the needle thread regulator:

1. Loosen the fastening screw (2).
2. Move the needle thread regulator (3):

• Lower thread quantity: 
Slide the needle thread regulator (3) to the right

• Larger thread quantity: 
Slide the needle thread regulator (3) to the left

3. Tighten the fastening screw (2).

(1) - Screw (2) - Needle thread regulator

②

①
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Operation
4.8 Winding the hook thread
The separate winder allows the hook thread to be wound while sewing or 
independently of sewing.

Fig. 13: Winding the hook thread

To wind the hook thread:

1. Place the thread reel on the thread reel holder and guide the needle 
thread through the hole in the guide on the unwinding bracket.

Important
The unwinding bracket must be parallel to the thread stand.

2. Insert the thread in a wavelike manner through the two rear holes of 
the thread guide plate (1): From top to bottom through the rear hole 
and from bottom to top through the left hole.

3. Feed the thread from top to bottom through the thread guide 
channel (2).

4. Guide the thread counterclockwise around the winding tensioner (3).
5. Insert the thread in a wavelike manner through the two remaining free 

holes of the thread guide plate (1): From bottom to top through the rear 
hole and from top to bottom through the front hole.

6. Feed the thread to the winder, clamp the thread behind the cutter (6) 
and tear the thread off.

7. Plug an empty bobbin on the winding shaft (5) and turn clockwise until 
it clicks into place.

(1) - Thread guide plate
(2) - Thread guide channel
(3) - Winding tensioner

(4) - Bobbin winder flap
(5) - Bobbin shaft
(6) - Cutter

④

⑤
⑥①

②

③
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Operation
8. Press the bobbin winder flap (4) against the bobbin.
 The winder starts and stops automatically when the configured bob-

bin filling volume is reached. 
(Setting of the bobbin filling volume is described in the  Service 
Instructions.)

4.9 Changing the bobbin

Fig. 14: Changing the bobbin (1)

To change the bobbin:

1. Remove the sewing material holder (1) (for alternating frames only).
2. Press the threading mode (2) button.
 The drive carriage moves to the bobbin change position.

The cover plate (3) pivots to the side.
The sewing foot is moved to the lower position.
The lighting is switched on.

WARNING
Risk of injury from sharp and moving parts!
Puncture or crushing possible.

Switch the machine to threading mode before 
changing the bobbin.
When threading mode is active, do not reach into 
the hook area until the cloth pressure bar has 
moved down.

(1) - Sewing material holder
(2) - Button for threading mode

(3) - Cover plate

① ② ③
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Operation
Fig. 15: Changing the bobbin (2)

3. Push up the bobbin case retainer (6).
4. Remove the empty bobbin.
5. Insert a full bobbin.
Important
Insert the bobbin (5) so that it moves in the opposite direction of the hook 
when the thread is pulled out. The slits of the bobbin should be visible at 
the top.

6. Feed the hook thread through the slot (9) in the bobbin case.
7. Pull the hook thread under the tensioning spring (8).
8. Pull the hook thread through the guide (7) and place it to the left.
9. Close the bobbin case retainer (6).
10. Cut off the thread at the left edge of the closed bobbin flap.
11. Release the threading mode (2) button.
 The cover plate (4) pivots back to the original position.

Accounting for a bobbin change in the seam program
The method of accounting for a bobbin change in the seam program is 
described in the chapter Changing the bobbin ( p. 47).

(4) - Bobbin
(5) - Bobbin case retainer
(6) - Guide

(7) - Tensioning spring
(8) - Slot

⑧

④

⑤

⑥

⑦
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4.10 Setting the hook thread tension

Fig. 16: Setting the hook thread tension

The hook thread tension is generated by the tension spring (1) and adjust-
ed via the adjustment screw (2).

Increasing hook thread tension
1. Turn the adjusting screw (2) clockwise.

Reducing hook thread tension
1. Turn the adjusting screw (2) counterclockwise.

WARNING
Risk of injury from sharp and moving parts!
Puncture or crushing possible.

Depressurize the machine and manually open the 
bobbin flap before setting the hook thread tension.

(1) - Tensioning spring (2) - Adjusting screw

① ②
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5 Programming
The control is operated via the operating terminal (1) that is found next to 
the machine head.

Fig. 17: Operating the control

The screen is a touchscreen, i.e. the buttons are displayed on the screen 
rather than using physical buttons. Buttons or functions are activated by 
tapping the corresponding position on the monitor.

Activating a button/selecting an element:
1. Tap the corresponding button or element with your finger or a touch-

screen pen.

(1) - Operating terminal

①
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5.1 Structure of the software
The software allows the creation and management of seam programs and 
sequences. During sewing, these programs are called up and processed 
stitch for stitch. 

Seam program:
A seam program consists of a seam contour with parameters defining the 
individual contour sections.
Up to 99 seam programs can be stored in the system.
Seam programs have a file suffix of .fnp911 after the filename.

Sequence:
Up to 30 seam programs can be combined in any order to form a sequence.
Up to 20 sequences can be stored in the system.
Sequences have a file suffix of .seq911 after the file name.

The software is also used to define general settings that apply to all pro-
grams. There are also technical menu items for testing and maintaining 
the machine.

5.2 Overview of the menu structure
The following table provides an overview of the menu structure and the 
function buttons on the start screen.

Different colors indicate which functions are mainly used for normal sew-
ing operations, which items are used for creating and maintaining seam 
programs and the menu items that are used for making technical settings.

Green: Menu items for sewing

Blue: Menu items for creating and managing programs

Magenta: Menu items for technician settings and information (can only be 
opened with password)

Menu items in popup menus

Menu item Function Subitems Subitems Described on
File Open existing sewing 

programs, create new 
programs, copy or delete 
existing programs.

Löschen (Delete)  p. 72
Kopieren (Copy)  p. 56
Öffnen (Open)  p. 43
Neu (New) Nahtprogramm 

(Seam program)
 p. 48

Sequenz (Sequence)  p. 52
Speichern unter 
(Save As)

 p. 55
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Bearbeiten 
(Edit)

Define general settings 
for all programs or mod-
ify an existing program.

Maschinenparameter 
(Machine Parameters)

 p. 66

Sequenz (Sequence)  p. 66
Nahtprogramm 
(Seam program)

Parameter  p. 60
Konturanpassung 
(Contour Adjustment)

 p. 60

Konturtest
(Contour Test)

 p. 51

Extras Display options: full-
screen and zoom

Technician menu:
Settings, system 
information and tests

Vollbild ein/aus
(Full-screen on/off)

 p. 42

Zoom ein/aus
(Zoom on/off)

 p. 42

Service 
(nur mit Passwort - 
only with password)

Einstellungen
(Settings)

 p. 72

System-Information 
(System Information)

 p. 79

Multitest  p. 72
Initialisierung
(Initialization) 
und Update
(and update)

 p. 80

Manufacturer (for DA personnel only)
Korrektur
(Correction)

Short-term sewing with 
other values

Fadenspannung 
(Thread tension)

 p. 44

Nähdrehzahl (Speed)  p. 45

Buttons on the main screen

Continue sewing the contour from a particular 
point

Reparatur-Modus 
(Repair mode)

 p. 47

Allow for a manual bobbin change Spulenwechsel 
(Bobbin change)

 p. 45

Reset counter to a particular value Zählerreset
(Reset counter)

 p. 47

Menu items in popup menus

Menu item Function Subitems Subitems Described on
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5.3 Starting the software
After being switched on at the main switch, the machine needs to be ref-
erenced. After this, the start screen is shown on the operating terminal for 
a few seconds.

Fig. 18: Starting the software

Here you can select the user interface language or use Service to 
quickly access the Multitest menu.

Information
Both functions can also be accessed later from within the program via 
Extras > Service. 
(See chapters Testing the functions of the machine ( p. 77) and 
Changing the language ( p. 76))

If you do not tap any buttons, the software automatically switches to the 
start screen after a few seconds.

(1) - Button language selection (2) - Multitest quick-access button

① ②
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The start screen
The start screen is displayed during sewing. When the machine is started, 
the main screen is opened with the settings of the last sewing program 
used.

Fig. 19: Start screen

Structure of the start screen

Title bar (1)
This shows the version of the machine on the start screen. It also contains 
information on the menu item currently selected in the various menus.

Status bar (2)
On the start screen, the sequence currently open is displayed here, and 
the time of day (11) is displayed at the right. It also bar contains informa-
tion on the currently selected step in the various menus.

Main window (3)
The contour to be sewn is displayed here.

Program bar (4)
The seam programs of the sequence currently open are displayed here. 
The program currently being executed is highlighted in black. The arrow 
buttons (6) at the right side of the bar can be used to navigate along the 
bar and display any additional programs that do not fit on the bar.
If a sequence is not currently open but rather only a single seam program 
then this program fills the entire bar.

(1) - Title bar
(2) - Status bar
(3) - Main window Display of the 

seam contour
(4) - Program bar
(5) - Menu bar: Popup menu

(6) - Button for resetting the counter
(7) - Button for bobbin change
(8) - Button of the current seam parameters
(9) - Button for repair mode
(10) - Display of time

③

④
⑤

⑥
⑦

⑨

⑩

⑧

①
②
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Menu bar (5)
The bar at the bottom contains the popup menus. This allows you to ac-
cess the various different menu items for creating and editing seam pro-
grams and for performing settings and tests on the machine. An arrow (1) 
next to a menu entry indicates that tapping the entry will display further 
subitems.

Fig. 20: Popup menu

Button for repair mode (9)
The topmost button at the right side is used for switching the repair mode 
on and off. The current status (Ein (On)/Aus (Off)) is displayed 
next to the button.

Display of the current seam parameters (8)
The current seam parameters are displayed below the repair mode button

•  - Dimensions of the seam

•  - Sewing speed

•  - Thread tension

•  - Stitch length

•  - Number of stitches / hook thread consumed

Information
You can use the buttons Speed, Thread tension and Stitch length to access 
the seam parameters directly ( p. 63).

(1) - Popup arrows

①
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Button for bobbin change (7)
This button is used to inform the system that a new bobbin has been in-
serted (e.g. after a color change). The hook thread capacity is displayed 
next to this button.

Button for resetting the counter (6)
This button can be used for resetting the counter for the sewn programs 
or sequences. The current counter value is displayed next to this button.

5.4 General operation of the software

5.4.1 Entering a password
Depending on the setting (see chapter Changing the password 
options ( p. 75)) a password is only required for accessing the techni-
cal menus or must be entered every time the machine is started. 
The password entry screen is displayed when a password is required.

Fig. 21: Entering a password

Entering a password
To enter a password:

1. Use the numeric buttons (2) to enter the password.

Information
The default password on delivery is: 25483.
The password can be changed via the Extras menu ( p. 75).
You can delete incorrect entries via the DEL button.

2. Tap the OK button.
 The previously selected menu item opens.

(1) - Input field (2) - Numeric buttons

①

②
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5.4.2 Closing windows
A number of different buttons can be used for closing the currently open 
window.

5.4.3 Display principles

Fig. 22: Display principles

The currently activated or selected element is highlighted with a dark 
background (2).

Buttons that are not used in the current context are grayed-out (1).

Button Meaning
At the upper right in the title bar of all windows:
 The program jumps back by one navigation level.

OK
CR

In windows with data entry or selection fields:
 The window is closed and the entered or selected data is adopted. 

DEL
Cancel
Cancel

In windows with data entry or selection fields:
 The window is closed and the entered or selected data is 

discarded.

(1) - Grayed-out: Deactivated element (2) - Dark background: Activated element

②

①
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5.4.4 Scrolling the display

Fig. 23: Scrolling the display

A scrollbar (1) is displayed on the right when a displayed image is larger 
than the screen height.

Moving image up/down
To move the image up or down:

1. Drag the scrollbar (1) up or down.

5.4.5 Selecting options from a list
When selecting options, a distinction is made between round option but-
tons and square checkboxes

Selection with option buttons

Fig. 24: Selection with option buttons

With round option buttons only one of the displayed options can be selected.

(1) - Scrollbar

①

(1) - Option buttons: Selected element

①
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To select options using checkboxes:

1. Tap the desired option.
 The selected option (1) is marked with a dot.

Selection with checkboxes

Fig. 25: Selection with checkboxes

Checkboxes allow the selection of multiple entries

To select options using checkboxes:

1. Tap the desired checkboxes
 The selected entries (1) are marked with a cross.

5.4.6 Using file filters
When opening, copying or deleting seam programs a list of all available 
files is displayed.

You can use the filter functions to make the list more manageable:

To use file filters:

1. Tap the Dateifilter (File Filter) button under the list.
 The file filter screen opens.

(1) - Checkbox: Selected elements

①
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Fig. 26: File filter

2. Tap the desired filter criterion:
• .fnp911: Seam programs only

• .seq911: Sequences only

• All Files: Seam programs and sequences
3. Tap the Öffnen (Open) button.
 The list is updated according to the selected filter.

5.4.7 Entering text
A text entry window is displayed when text needs to be entered, e.g. for 
the name of a program.

Fig. 27: Entering text

Entering text
1. Use the keyboard (2) displayed to enter the text.

(1) - Input line
(2) - Keyboard
(3) - OK (CR): Adopt the entered text

(4) - DEL: Delete a character
(5) - Aa: Switch between uppercase/lowercase

①

②

③
④
⑤

Operating Instructions 911-211 - 05.0 - 08/2019 41



Programming
Switching between uppercase/lowercase
1. Tap the Aa (5) button.

Deleting the last character
1. Tap the DEL (4) button.

Adopting the entered text
1. Tap the CR (3) button.
 The entered text is adopted and the text entry window is closed.

5.4.8 Entering parameter values
A numeric entry window opens when numeric values for program or ma-
chine parameters need to be entered.

Fig. 28: Entering parameter values

The title bar (1) shows the parameter group.

The status bar (2) shows the name of the parameter currently being edit-
ed. The symbol (3) for the corresponding parameter is display below the 
parameter name.

The prescribed value range (4) for the parameter is displayed below the 
symbol (3).

The current valid value is displayed in the data entry field (5) below the val-
ue range (4).

Entering a value
1. Tap the desired numeric buttons (6).

(1) - Title bar
(2) - Status bar
(3) - Symbol

(4) - Value range
(5) - Input field
(6) - Numeric buttons

①

②
③
④
⑤

⑥
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Deleting a value
1. Tap the DEL button.

Adopting a value
1. Tap the OK button.
 The entered value is adopted and the numeric entry window is 

closed.

5.4.9 Switching the full-screen display on and off
In order to see the seam contour in more detail you can switch the main 
window (1) to occupy the full screen and hide the buttons (2) on the right 
side of the start screen.

Fig. 29: Switching the full-screen display on and off

To switch full-screen on and off:

1. Tap the menu items Extras > Vollbild ein/aus
(Full-screen on/off).

 The display switches to the respective other mode.

(1) - Full-screen switched off (2) - Full-screen switched on

① ②
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5.4.10 Switching zoom on and off
You can magnify the display in order to see the seam contour in more de-
tail. There is only one zoom level that can be switched on or off.

Fig. 30: Switching zoom on and off

To switch zoom on and off:

1. Tap the menu items Extras > Zoom ein/aus (Zoom on/off).
 The display switches to the respective other mode.

5.5 Opening a seam program or sequence for sewing
You will usually open an existing seam program or and existing sewing 
sequence.

To open a seam program or sewing sequence:

1. Tap the menu items Datei (File) > Öffnen (Open).
 The file selection screen is displayed.

All existing seam programs and sequences are displayed.

Information
You can use the Dateifilter (File Filter) to make the list 
more manageable ( p. 40).

(1) - Zoom switched off (2) - Zoom switched on

① ②
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Fig. 31: Opening a seam program or sequence for sewing

2. Tap the desired file.
3. Tap the Öffnen (Open) button.
 The seam program/sequence is opened on the start screen.
4. Press the pedal forwards to start sewing.

5.6 Briefly sewing with modified values
If you need to briefly sew a special material or use a particular thread 
strength with different values, without changing the seam program, you 
can use the Korrektur (Correction) menu item to temporarily 
change the values for thread tension and speed. The values then apply to 
all subsequently executed seams until the machine is switched off. 

Important
If you wish to adopt the changes then you must modify and save the pro-
gram. Otherwise the values are automatically reset to the previous set-
tings when the machine is switched off. 
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5.6.1 Sewing with a modified thread tension
To sew with a modified thread tension:

1. Tap the menu items Korrektur (Correction) > 
Fadenspannung (Thread Tension).

 The window for changing the thread tension appears:

Fig. 32: Sewing with a modified thread tension

2. Enter the desired thread tension value.
3. Tap the OK button.
 The value is adopted and used for all seams until the machine is 

switched off.

5.6.2 Sewing with a modified sewing speed
To sew with a modified speed:

1. Tap the menu items Korrektur (Correction) > 
Nähdrehzahl (Speed).

 The window for changing the thread tension appears:

Fig. 33: Sewing with a modified sewing speed

2. Enter the desired speed.
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3. Tap the OK button.
 The value is adopted and used for all seams until the machine is 

switched off.

5.7 Changing the bobbin

The machine automatically detects when the hook thread has been used 
up and a new bobbin needs to be inserted.

In this case, or if thread breakage occurs, the Fadenriss behandeln 
(Manage Thread Breakage) window is automatically displayed.

Fig. 34: Change bobbin

To change the bobbin:

1. Tap the Change Bobbin button.
2. Change the bobbin ( p. 28).
3. Use the Vor (Forwards) and Zurück (Back) buttons to 

move to the point where sewing is to continue.
4. Tap the Continue Sewing button.
 The program jumps back to the start screen and sewing of the seam 

continues from the selected point.

WARNING
Risk of injury from sharp and moving parts!
Puncture or crushing possible.

Switch the machine to threading mode before 
changing the bobbin.
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Bobbin change without a request from the program
If you wish to independently insert a new bobbin without being requested 
to do so by the program, e.g. when changing color, then you have to tap 
the Spulenwechsel (Bobbin Change) button on the start screen after 
changing the bobbin to inform the program that a new bobbin has been 
inserted and that thread consumption should resume from the value cor-
responding to the full bobbin capacity.

Updating the bobbin capacity
To update the bobbin capacity:

1. Tap the button Spulenwechsel (Bobbin Change)  on the 
start screen.

 The counter for the bobbin capacity begins anew with a full bobbin.

5.8 Continuing a seam in Repair mode after an error
In Repair mode you can move to any desired point on the contour, e.g. in 
order to continue the seam program from this position after an error has 
occurred.

To continue a seam in Repair mode after an error:

1. Tap the button Reparaturmodus (Repair mode)  on the 
start screen.

 The Reparaturmodus (Repair mode) window is displayed.

Fig. 35: Continuing a seam in Repair mode after an error

2. Use the Vor (Forwards) and Zurück (Back) buttons to move to the 
point where sewing is to continue.

OR

3. Use the buttons Vor ++ (Forwards) and Zurück ++ (Back) to skip to 
the beginning of the next or the beginning of the previous seam section.
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4. Tap the Weiternähen (Continue Sewing) button.
 The program jumps back to the start screen and sewing of the seam 

continues from the selected point.

5.9 Continuing a seam after thread breakage
When the machine was set up, the needle thread monitor mode that is 
supposed to be active was selected in the machine parameters 
(MP 3 ( p. 72)).

In the event of an error, e.g. thread breakage, the machine will undo a cer-
tain number of preset stitches and stop.

The control panel will show the display Fadenriss behandeln 
(Manage Thread Breakage):

Fig. 36: Continuing a seam after thread breakage

To continue a seam after thread breakage:

1. Re-thread the needle thread.

2. Use the Vor (Forwards) and Zurück (Back) buttons to move to the 
point where sewing is to continue.

3. Continue sewing.

To cancel sewing after thread breakage and start a new seam:

1. Tap the Abbruch (Cancel) button.
2. Remove the transfer plate.
3. Press the pedal backwards.
 The machine performs a reference run.
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4. Press the pedal forwards.
 The machine moves to the loading position, and you can start a new 

seam.

If necessary, you can also check or change the bobbin.

To change or check the bobbin:

1. Tap the Spulenwechsel (Change Bobbin) button.
 The display shows a prompt asking whether you wish to reset the 

bobbin counter.
2. Tap the JA (YES) button if you wish to change the bobbin.
 The bobbin counter will be reset.
OR

3. Tap the NEIN (NO) button if you merely wish to check the bobbin.
 The bobbin counter will not be reset.
4. Remove the transfer plate.
5. Tap the Einfädelmodus (Threading mode) button on the machine 

head.
 The hook cover opens.
6. Change or check the bobbin.
7. Tap the Einfädelmodus (Threading mode) button on the machine 

head.
 The hook cover closes.
8. Press the pedal forwards.
 The machine moves into the insertion position.
9. Insert the transfer plate.
10. Press the pedal or tap the Weiternähen (Continue Sewing) button.
 The machine moves to the sewing position.
11. Press the pedal or tap the Weiternähen (Continue Sewing) button.
 The sewing procedure is resumed.
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5.10 Resetting the counter
Depending on the machine parameter settings, the counter counts the 
sewn programs or sequences up or down. You can use the Zähler-Reset 
(Reset Counter) button to reset the counter to the start value ( p. 73).

To reset the counter:

1. Tap the button Zähler-Reset (Reset Counter)  on the start 
screen.

 The counter is reset to the value defined in the machine parameters.

5.11 Creating a new seam program
New seam programs are created using a Teach-In procedure. 

Individual seam paths with specific seam parameters are defined via the 
operating terminal in order to do this.

To create a new seam program:

1. Tap the menu items Datei (File) > Neu (New) >
Nahtprogramm (Seam Program).

 The Teach-In window appears.

Fig. 37: Creating a new seam program

(1) - Cursor position
(2) - Cursor
(3) - Arrow buttons
(4) - OK button: Übernahme (Accept)

(5) - Speichern (Save) button
(6) - Löschen (Delete) button
(7) - Parameter button
(8) - Linienauswahl (Line selection) button

②

③ ④
⑤
⑥
⑦

⑧

①
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Defining the starting point
2. Define the starting point:

3. Tap the OK button.
 The desired starting point is adopted and marked with a green dot.

Selecting the line type
4. Use the line selection buttons (8) to select the type of line to be defined.

•   Seamless path: 
The clamps move over this path to the next position without sewing.

•   Straight seam: 
A straight path is sewn.

•   Curved seam: 
A curve is sewn.

 After tapping the button for a straight or curved seam the correspond-
ing window for entering the seam parameters for this path opens.

Method Coordinate-Range

With the arrow buttons (3)

Attention
For safety reasons you cannot choose positions over 90,1 
oder -92,6 on the Y-axis with the arrow buttons (3).
For adjustments in excess of these coordinates you must 
use the pedal.

X -150 to X 230
Y 90,1 to Y -92,6

With the pedal

Each pedal step moves the cursor by 0,1 in the direction of 
the chosen axis (X or Y)

X -150 to X 230
Y 100 to Y -100

Insert the coordinates directly by the cursor postion (1) X -150 to X 230
Y 100 to Y -100
52 Operating Instructions 911-211 - 05.0 - 08/2019



Programming
Defining the seam parameters for the path

Fig. 38: Defining the seam parameters for the path

5. Tap the respective parameter.
 The window for entering the parameter value opens.
6. Enter the desired value for the parameter ( p. 42).

Seam parameters for teach-in
Button Meaning

Speed

Stitch length

Thread tension

Stroke height

Cut thread
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Drawing a path
7. Use the arrow buttons to move the cursor to the end point of the desired 

path.

Information
Alternatively, you can tap an arrow button once in order to define the di-
rection and then continue moving in this direction by pressing the pedal.

Important
Take care to ensure that the contour remains within the permissible sew-
ing field of your particular machine. Especially with curved paths, you 
should remember that the start and end points are not directly connected 
and that a curve is generated between these two points.

8. Tap the OK button.
 The seam path is adopted with the specified parameters.

Adding further seam paths
You can now define all further seam paths in the same manner. 

1. Add each new seam path by starting at step 4.

Deleting a seam path
1. Tap the Löschen (Delete) button.
 The last section of the seam path is deleted. 

Saving the program
After you have defined all the seam paths you can save the program and 
specify a name for the program.

1. Tap the Speich... (Save) button.
 The window for entering the program name opens.
2. Enter the desired name ( p. 41) and adopt the name by pressing CR.
 The program is now available under this name for sewing, editing or 

copying.
Important
Always perform a contour test after creating a new program ( p. 55). 
Ensure that the contour lies within the sewing field limits of your particular 
unit.
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5.12 Performing a contour test
Always perform a contour test every time after creating or editing a pro-
gram to ensure that the entire contour lies within the permissible sewing 
field

To perform a contour test:

1. Tap the menu items Bearbeiten (Edit) > Nahtprogramm 
(Seam program) > Konturtest (Contour test).

 The Contour test window appears.

Fig. 39: Performing a contour test

2. Move along the contour stitch by stitch using the Vor (Forwards) and 
Zurück (Back) buttons.

3. Check that all points lie within the sewing area.

NOTICE

Property damage may occur!
If you have entered contour points that lie outside the sewing field, 
the movement of the clamps during sewing can cause damage to the 
machine or the sewing material.

Always perform a contour test after creating or editing a contour to 
ensure that the entire contour lies within the permissible sewing field.
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5.13 Creating a new sequence
You can combine up to 30 seam programs to form a sequence. You can 
create up to 20 sequences.

1. Tap the menu items Datei (File) > Neu (New) > Sequenz 
(Sequence).

 The window for selecting the seam program appears.

Fig. 40: Creating a new sequence

The existing seam programs are displayed at the right side of the screen. 
The Sequenz (Sequence) field on the left shows the seam programs 
that have been transferred to the sequence.

2. Tap the desired program
 The selected program is highlighted with a dark background.
3. Tap the Einfügen (Insert) button.
 The seam program is transferred to the sequence and is displayed in 

the Sequenz (Sequence) field on the left side of the screen.
4. Add further seam programs in the same manner.

Removing a program from a sequence
1. Tap the seam program in the Sequenz (Sequence) field and 

then tap the Löschen (Delete) button.
 The program is removed from the sequence.

Assigning a name to the sequence
1. Tap the Namen eingeben (Enter Name) button.
 The window for entering the sequence name opens.
2. Enter the desired name and adopt the change by pressing 

CR ( p. 41).
 The sequence is now available under this name for sewing, editing or 

copying.
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5.14 Editing an existing sequence
You can edit an existing sequence by adding or removing seam programs.

To edit an existing sequence:

1. Open the program you wish to modify via the menu items Datei 
(File) > Öffnen (Open).

 The sequence opens on the start screen.
2. Tap the menu items Bearbeiten (Edit) > Sequenz 

(Sequence).
 The window for editing the sequence appears.

Fig. 41: Editing an existing sequence

3. Use the buttons Einfügen (Insert) and Löschen (Delete) to add pro-
grams to the sequence or remove programs from the sequence. 
The steps correspond to the procedure used for creating a new 
sequence ( p. 56). 
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5.15 Saving a seam program/sequence under a different name
You can save a seam program or sequence under a different name.

Information
For example, if you wish to create a new program that is similar to an 
existing program you do not need to create the entire program anew. 
You can save the existing program under a new name and simply change 
the respective details.

To save a seam program or sewing sequence under a different name:

1. Tap the menu items Datei (File) > Speichern unter 
(Save As).

 A selection window allowing you to select a seam program or 
sequence appears.

Information
You can use the Dateifilter (File Filter) to make the list 
more manageable ( p. 40).

2. Tap the desired element.
3. Tap the Speichern unter (Save As) button.
 The window for entering the new name is opened.
4. Enter the desired name and adopt the change by pressing 

CR ( p. 41).
 The program or sequence is now also available under this name for 

sewing, editing or copying.
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5.16 Copying a seam program or sequence
You can also copy seam programs or sequences from a USB key to the 
control or from the control to a USB key.

Important
Not all commonly available USB keys are suitable for the copying process.
You can obtain a suitable USB key from Dürkopp Adler using the part 
number 9805 791113.

To copy a seam program or sequence:

1. Tap the menu items Datei (File) > Kopieren (Copy).
 The window for selecting the file to be copied appears:

Fig. 42: Copying a seam program or sequence

2. Use the buttons (1) to select whether the data is to be copied from the 
DAC control or the USB key.

 The selected button is highlighted with a dark background.
A selection window (2) lists all files present at this 
location.

Information
You can use the Dateifilter (File Filter) to make the list 
more manageable ( p. 40).

3. Tap the desired file.
 The selected file is highlighted with a dark background.
4. Tap the Datei kopieren (Copy File) button.
 The selected file is copied to the USB key or the control.

(1) - Select the source to be copied (2) - File selection window

① ②
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5.17 Deleting a seam program or sequence
Seam programs or sequences that are no longer required can be deleted 
from the control.

To delete a seam program or sequence:

1. Tap the menu items Datei (File) > Löschen (Delete).
 The window for selecting the file to be deleted appears:

Fig. 43: Deleting a seam program or sequence

Information
You can use the Dateifilter (File Filter) to make the list 
more manageable ( p. 40).

2. Tap the desired file.
 The selected file is highlighted with a dark background.
3. Tap the Löschen (Delete) button.
 The selected file is deleted.
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5.18 Editing an existing seam program
You can change the contour and parameters of existing seam programs. 
The changes are applied to the seam program that is currently open on 
the start screen.

To edit an existing seam program:

1. Open the program you wish to modify via the menu items Datei 
(File) > Öffnen (Open).

 The program opens on the start screen.

5.18.1 Changing the contour of a seam program

To edit an existing seam program:

1. Tap the menu items Bearbeiten (Edit) > Nahtprogramm 
(Seam program) > Konturanpassing (Adjust 
Contour).

 The contour adjustment window appears:

Fig. 44: Changing the contour of a seam program (1)

2. Use the arrow buttons to move the cursor (1) to the position on the 
contour that is to be changed.

NOTICE

Property damage may occur!
If you have entered contour points that lie outside the sewing field 
then the movement of the clamps during sewing can cause damage 
to the machine or the sewing material.

Always perform a contour test after creating or editing a contour to 
ensure that the entire contour lies within the permissible sewing field.

(1) - Cursor (2) - Scale: First to last stitch

① ②
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Information
You can also use the slider control on the scale (2) to select the stitching 
area you wish to change:
The first stitch of the seam is at the top and the last stitch is at the bottom.

3. Tap the Go To button.
 The selected contour region is displayed in detail.

The stitching point (2) to be modified is marked in red.

Fig. 45: Changing the contour of a seam program (2)

4. Use the arrow buttons to move the stitching point to the new position (4).
 The modified seam path is displayed in green.
5. Tap the Weiter (Next) button.
 The window for entering the technology operations opens.

Fig. 46: Changing the contour of a seam program (3)

6. Select the desired technology operation(s) for the new seam 
path ( p. 39).

(3) - Old stitching point (4) - New stitching point

④

③
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7. Confirm the selection with OK.
 You are returned to the detail window with the modified contour.
8. Tap the Weiter (Next) button again.
 A query dialog is displayed, asking if you wish to adopt the changes. 

Agreeing to this dialog will save the modified contour.

Important: Always perform a contour test after modifying a contour to 
ensure that the new seam path lies within the permissible sewing 
field ( p. 55).

5.18.2 Changing the parameters of a seam program
You can also change the general settings that apply to the entire seam 
program.

To change the parameters of a seam program:

1. Tap the menu items Bearbeiten (Edit) > Nahtprogramm 
(Seam program) > Parameters.

 The window for selecting the program parameter group appears:

Fig. 47: Changing the parameters of a seam program

2. Tap the desired parameter group.
 The individual parameters of this group are displayed.
3. Tap the desired parameter.
 The window for modifying the parameter value opens.
4. Set the parameter to the desired value ( p. 42).
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There are 8 program parameter groups:

Overview of the individual program parameters

Symbol Parameter group
PP1 - Configuration
General settings

PP2 - Insertion mode
Insertion mode and position

PP3 - Removal mode
Removal mode and position

PP4 - Softstart
Number of stitches and speed

PP5 - Needle thread monitor
Sensitivity value for the needle thread monitor

PP6 - Thread consumption
Values for determining thread consumption

PP7 - Offset:
Contour is offset in a particular direction

PP8 - Scaling: 
The size of the contour is changed.

PP1 - Configuration

Symbol Meaning
Seam name
max. 20 characters

Minimum sewing foot stroke height
(min. = 1.0 .. max. = 10.0; Def. = 5.0 mm)
Sets this as the minimum value of the programmable sewing foot stroke 
height so that only this value needs to be adjusted when sewing thicker 
materials.
Adjusting the thread tension
(min. = 10… max. = 200; Def. = 100%)
The thread tension profile for the entire contour is adjusted accordingly. 
A value of 100% means that no adjustments are made.
Adjusting the run-empty speed
(min. = 10… max. = 200; Def. = 100%)
The forwarding speeds are adjusted accordingly.

Clamp ID code
Barcode (ID code) of max. 10 characters for performing a safety check 
before the start of sewing (the barcode reader additional equipment must 
be activated)
Laser marking lights
Up to four laser marking lights for easier alignment of the sewing material 
can be controlled (the additional equipment must be activated)
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Needle reversing mode 
The following options can be set:
Not active: The needle remains at the Stop position.
After the entire contour: After completing all seams in the contour the 
needle is reversed to the value specified in the machine parameters.
After every seam (Def.): The needle is reversed after every seam.
Needle cooling
(On/Off)
Activates/deactivates the needle cooling.

Adjusting sewing speed
(min. = 10… max. = 200; Def. = 100%)
The sewing speed is adjusted by the specified percent value.

PP2 - Insertion mode

Symbol Meaning
Insertion mode
The following options can be set:
Mode 1 (Def.)
Clamp is opened in the insertion position. The clamp is closed when the 
pedal is pressed. Pressing the pedal again starts sewing of the seam.
Mode 2
Clamp is opened in the insertion position. Pressing the pedal closes the left 
part of the two-piece clamp for angle mounting. Pressing the pedal again 
closes the right part. Pressing the pedal again starts sewing of the seam.
Mode 3
Clamp is opened in the insertion position. Pressing the pedal closes the 
right part of the two-piece clamp for angle mounting. Pressing the pedal 
again closes the left part. Pressing the pedal again starts sewing of the 
seam.
Mode 4
Quick-start mode:
Clamp is opened in the insertion position. The clamp is closed and sewing 
of the seam is started when the pedal is pressed. With the alternating clamp 
the seam is automatically started after insertion.
This mode is only active when quick-start is enabled in the machine param-
eters. The machine must be switched off and on in order to enable the 
quick-start mode.
Mode 5
Clamp is remains closed in the insertion position. Pressing the pedal again 
starts sewing of the seam.
Insertion position
(On/Off)
With the insertion position activated the clamps move to the desired posi-
tion for convenient insertion of the sewing material.

Symbol Meaning
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Insertion position X
The value range varies depending on the subclass and sewing field size.

 Insertion position Y
The value range varies depending on the subclass and sewing field size.

PP3 - Removal mode

Symbol Meaning
Removal mode
The following options can be set:
Mode 1 (Def.)
Clamp is opened in the removal position.
Mode 2
Clamp remains closed in the removal position. The clamp is opened when 
the pedal is pressed. 
Mode 3
Clamp remains closed in the removal position. Pressing the pedal opens 
the left part of the two-piece clamp for angle mounting. Pressing the pedal 
again opens the right part.
Mode 4
Clamp remains closed in the removal position. Pressing the pedal opens 
the right part of the two-piece clamp for angle mounting. Pressing the pedal 
again opens the left part.
Mode 5
Clamp remains closed in the removal position.
Removal position
(On/Off)
With the removal position activated the clamps move to the desired position 
for convenient removal of the sewing material after the sewing procedure.
Removal position X
The value range varies depending on the subclass and sewing field size.

Removal position Y
The value range varies depending on the subclass and sewing field size.

PP4 - Softstart

Symbol Meaning
Number of softstart stitches
(min. = 0 .. max. = 10; Def. 5.

Softstart speed
 (min. = 100 .. max. 2000; Def. 300 rpm)

Symbol Meaning
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PP5 - Needle thread monitor

(min.=0..max.= 99: Def. 5.
Is only active if activated in the machine parameters.
(A higher value makes the needle thread monitor less sensitive. 
99 = Needle thread monitor switched off in this program only.)

PP6 - Thread consumption

Symbol Meaning
 Sewing material thickness (min. = 0.. max. 20.0; Def. 0.
 The thickness of the sewing material when pressed together.

Material consumption adjustment
 (min. = -10.0 .. max. 10.0; Def. 0.
 Correction of the calculated values.

PP7 - Offset

Symbol Meaning
X offset 
(min. = -5.0… max. = 5.0; Def. = 0.0 mm)

Y offset 
(min. = -5.0… max. = 5.0; Def. = 0.0 mm)

PP8 - Scaling.

Symbol Meaning
X scaling 
(min. = 80… max. = 120; Def. = 100 %)
100% corresponds to the original size.

Y scaling 
(min. = 80… max. = 120; Def. = 100 %)
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5.19 Editing machine parameters
You use the machine parameters to define the basic machine settings that 
apply to all programs.

To edit the machine parameters:

1. Tap the menu items Bearbeiten (Edit) >
Machinenparameter (Machine parameters).

 The window for selecting the machine parameter group appears.

Fig. 48: Editing machine parameters

2. Tap the desired parameter group.
 The individual parameters of this group are displayed.
3. Tap the desired parameter.
 The window for modifying the parameter value opens.
4. Set the parameter to the desired value ( p. 42).

X scaling origin 
(min. = -150.0… max. = 150.0; Def. = 0.0 mm)

Y scaling origin 
(min. = -150.0… max. = 150.0; Def. = 0.0 mm)

Symbol Meaning
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There are 6 machine parameter groups:

Overview of the individual machine parameters

Symbol Parameter group
MP1 - Configuration
General settings

MP2 - Limit values
Limit values for speeds and positions

MP3 - Needle thread monitor
Behavior after thread breakage

MP4 - Thread cutting
Speed, position and tension

MP5 - Thread clamping
Starting angle

MP6 - Counters
Settings for program and bobbin counters

MP1 - Configuration

Symbol Meaning
Needle cooling 
The following options can be set:
None: No type of needle cooling is active. 
Air cooling (Def.): The needle is cooled with air while sewing the seam.
Ice cooling: Optional equipment.
Foot mode 
The foot can be operated in the following modes:
Hopper: The foot only presses on the sewing material while the needle is in 
the sewing material. 
Presser: The foot presses continuously on the sewing material.
Sewing field size 
Take care to ensure a valid sewing field size for your subclass when making 
the selection. (See chapter Technical data ( p. 127)).
Normal sewing field (Def.): A sewing field of up to 200 x 300mm is 
available.
Extra-large sewing field: A larger sewing field can be used in conjunction 
with the alternating clamps.
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Optional equipment 
Reduced clamp pressure: 
Optional equipment allowing only a small amount of clamp pressure to 
allow better alignment on insertion. 
Laser marking lights: 
Optional equipment providing orientation lines on insertion for easier align-
ment. Up to 4 laser marking lights can be switched on for each program. 
This setting only activates the option; the actual switching is defined in the 
program parameters (see Marking lamps ( p. 64)).
Barcode reader: 
Optional equipment for performing a safety check before sewing. 
A barcode can be stored with each program. Agreement with the barcode 
on the clamp is checked. Sewing only proceeds when the barcodes agree. 
You enter the barcode ID in the program parameters (see Clamp ID code 
( p. 64)).
Neat seam beginning:
Not available
Residual thread monitor:
Optional device that monitors the thread remaining on the bobbin. Will issue 
an alert before shortly before the thread is used up.
Thread burner:
Device for burning off the thread. Instead of cutting using a thread cutter.
Clamp type 
The following clamp types are available:
Single clamp: One-piece parallel clamp with angle mount
Single clamp with hanger (Def.): One-piece parallel clamp with hanger 
mount
Double clamp: Two-piece parallel clamp with angle mount
Alternating clamp: Removable clamp
Special clamp: Special clamp
Clamp limits 
Standard limits (Def.)
No additional structures are taken into account. 
Special limits
Individual limits are taken into account. 
Pedal mode 
The following options are available:
Mode 1: The current position of the pedal is evaluated. 
Mode 2 (Def.): The pedal must be returned to the home position after every 
actuation before a new actuation is recognized. 
Mode 3: The current position of the pedal is evaluated. 
The quick-start mode is also enabled (see Insertion mode ( p. 65)).
The machine must be switched off and on in order to enable the quick-start 
mode.
Hand sensor: In hand sensor mode one sensor is used only for controlling 
the clamp motion (up and down). The other sensor is used for starting the 
sewing process.
Barcode mode
The following options are available:
Manual: Machine checks whether the inserted clamp matches the entered 
seam program. If the clamp is correct, the machine is ready for sewing. 
If the clamp is incorrect, an error message will be displayed, and the clamp 
will have to be replaced.
Automatic: The machine looks for the seam program that matches the 
inserted clamp. The machine is ready for sewing once the seam program 
has been selected.

Symbol Meaning
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Information
The remaining thread monitor (MP 1, Optionale Einrichtungen (Optional 
equipment)) and the bobbin counter (MP 6) can be activated simultane-
ously. The display shows the two options as follows:

Fig. 49: Remaining thread monitor and bobbin counter

(1) - Display - remaining thread monitor:
Remaining thread monitor active:
R shown
Remaining thread monitor inactive:
R hidden

(2) - Display - bobbin counter:
Bobbin counter active: Number black
Bobbin counter inactive:
Number grayed-out

MP2 - Limit values

Symbol Meaning
Max. speed 
(min. = 500 .. max. 1400; Def. 900 rpm)
All sewing programs are limited to this maximum speed.

Max. run-empty speed 
(min. = 10 .. max. 100; Def. 100%)
Limits all clamp movements between the seams to this value.

Feed start angle 
(min. = 30 .. max. 350; Def. 300 degrees)
The clamp motion during the stitch starts at this angle of needle motion.

Feed phase 
(min. = 30 .. max. 100; Def. 30%)
This parameter defines how the clamp is to be moved during the stitch. 
(A value of 100% means that the desired clamp motion is distributed over 
the entire stitch.)
Needle reversing position 
(min. = 0 .. max. 359; Def. 0 degrees, with thread burner 20 degrees)
The needle is reversed at this angle in order to increase the clearance to 
the clamp.
 Edit time paths
 This function is only for Dürkopp Adler Service personnel.

① ②
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MP3 - Needle thread monitor

Symbol Meaning
Needle thread monitor mode
The following options are available:
Threading position: After detection of a thread breakage the thread is cut 
and the clamp then moves to the threading position. 
Cut thread (Def.): After detection of a thread breakage the thread is cut and 
the clamp then moves to the contour position according to the defined 
reversing path.
Remain in position: After detection of a thread breakage, seam motion is 
stopped.
Not active: The needle thread monitor is ignored.
Reversing path after thread breakage 
(min. = 0 .. max. 20; Def. 5 stitches)
Number of stitches to be taken into account when reversing after a thread 
breakage.
Bobbin change X position 
The value range varies depending on the subclass and sewing field size.

Bobbin change Y position 
The value range varies depending on the subclass and sewing field size.

MP4 - Thread cutting

Symbol Meaning
Cutting speed 
(min. = 70 .. max. 500; Def. 150 rpm)
Speed of the cutting stitch.

Cutting position on 
(min. = 0° .. max. 359°; Def. 180°)
Angular position of the needle at which the thread cutting knife is switched 
on.
Cutting position off
(min. = 0° .. max. 359°; Def. 359°)
Angular position of the needle at which the thread cutting knife is switched 
off.
Thread tension during thread cutting 
(min. = 00 .. max. 100; Def. 10%, 50% with thread burner)
Thread tension of the cutting stitch.

Position for thread tension during thread cutting 
(min. = 0° .. max. 400°; Def. 370°)
Starting angle for the thread tension during the cutting stitch.
(At an angle greater than 359° the thread tension is activated in the next 
stitch.)
72 Operating Instructions 911-211 - 05.0 - 08/2019



Programming
MP5 - Thread clamping (for TC machines only)

Symbol Meaning
Close thread clamp at 1st stitch 
(min. = 0° .. max. 250°; Def. 180°)
Start angle for closing the thread clamp during the first stitch.

Open thread clamp at 1st stitch 
(min. = 0° .. max. 359°; Def. 340°)
Start angle for opening the thread clamp during the first stitch.
If the closing and opening angles are the same then the thread clamp is not 
activated.

MP6 - Counters

Symbol Meaning
Counter type 
The following options are available:
Piece counter increments (Def.)
The counter is incremented after each sewn program.
Piece counter decrements 
The counter is decremented after each sewn program.
Sequence counter increments 
The counter is incremented after each sewn sequence.
Sequence counter decrements 
The counter is decremented after each sewn sequence.
Reset value for the counters
(min. = 0 .. max. 9999; Def. 0.
Value to which the counter is set when a counter reset is performed.

Seam counting for bobbin supply
(min. = 0 .. max. 100; Def. 0.
A message is displayed to the user after the number of seams specified 
here have been sewn. A value of 0 deactivates the function.
Bobbin supply capacity
(min. = 0.0 .. max. 400.0; Def. 0.0m)
A message is displayed to the user after the bobbin supply capacity has 
been consumed. A value of 0 deactivates the function.
Operating Instructions 911-211 - 05.0 - 08/2019 73



Programming
Information
The remaining thread monitor (MP 1, Optionale Einrichtungen (Optional 
equipment)) and the bobbin counter (MP 6) can be activated simultane-
ously. The display shows the two options as follows:

Fig. 50: Remaining thread monitor and bobbin counter

(1) - Display - remaining thread monitor:
Remaining thread monitor active:
R shown
Remaining thread monitor inactive:
R hidden

(2) - Display - bobbin counter:
Bobbin counter active: Number black
Bobbin counter inactive:
Number grayed-out

① ②
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5.20 Checking and changing the technical settings
The technical settings are made via the menu item Extras > Service.

Fig. 51: Checking and changing the technical settings

Important
A password must always be entered in order to access the additional 
menu items in Extras > Service ( p. 37).

Changing the password options
The default password on delivery is: 25483.

You can change this password and also define whether the password only 
applies to the technical menu items or must always be entered after the 
machine is switched on.

Changing the password
To change the password:

1. Tap the menu items Extras > Service > Einstellungen 
(Settings).

 The Einstellungen (Settings) window appears.

2. Tap the Operator Passwort (Password) option.

3. In the following window tap the option Passwort ändern 
(Change password).

 The window for entering the new password appears.
4. Enter the new password( p. 37).
Important
The password must not have more than 5 digits.

5. Confirm the new password with OK.
Operating Instructions 911-211 - 05.0 - 08/2019 75



Programming
Defining the password protected areas
To define the password protected areas:

1. Tap the menu items Extras > Service > Einstellungen 
(Settings).

 The Einstellungen (Settings) window appears.

2. Tap the Operator Passwort (Password) there.

 In the next window the Aktivieren/De-aktivieren 
(Activate/Deactivate) option indicates the type of pass-
word protection:

•   - Comprehensive password protection activated: 
Password protection of the first action after switching on

•   - Comprehensive password protection deactivated:
Password protection for the technical menu items only 

3. Tap the Aktivieren/De-aktivieren (Activate/
Deactivate) option to switch between each respective setting.

4. Confirm with OK.
Important
Switch the machine off and on again to adopt the setting.

Changing the language
To change the language:

1. In the menu item Extras > Service > Einstellungen 
(Settings) tap the Sprache (Language) option.

 The list of available languages is displayed.
2. Tap the desired language.
3. Confirm with OK.
 The screen is reloaded in the selected language.

Setting the date and time
To set date and time:

1. In the menu item Extras > Service > Einstellungen 
(Settings) tap the option Datum (Date) and Uhrzeit 
(Time).

 The data entry window for date and time is displayed.
2. Enter the date and/or time.
3. Confirm with OK.
 The entered values are adopted
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Setting the brightness
To set the brightness:

1. In the menu item Extras > Service > Einstellungen 
(Settings) tap the Bedienfeld-Einstellungen 
(Control panel settings) option.

2. In the following window tap the Kontrast (Contrast) 
Helligkeit (Brightness) option.

 A window with slider controls is displayed.
3. Pull the corresponding slider control up or down to change the value.
 The changes are immediately visible on the display.

Testing the touchscreen
You can use the Extras > Service > Einstellungen 
(Settings) menu item to check that the touchscreen is functioning 
correctly over all areas of the screen.

To test the touchscreen:

1. In the menu item Extras > Service > Einstellungen 
(Settings) tap the Bedienfeld-Einstellungen 
(Control panel settings) option.

2. In the following window tap the Touch Test option.
 An empty window is opened.
3. Use your finger to tap various different points or draw lines.
 When the touchscreen is functioning correctly all touched points of 

the screen are marked.

Testing the functions of the machine
You can use the Extras > Service > Multitest menu item to 
check the inputs and outputs, test the sewing motor and set the stroke 
position.

Fig. 52: Testing the functions of the machine
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Information

The functions  Transportklammer (Feed clamp) and 

 Fadenbrenner (Thread burner) are only intended for 
use by Dürkopp Adler Service personnel.

Testing inputs and outputs
Important
This manual only provides an overview of the test possibilities.

The tests may only be performed by qualified specialists that have received 
training from Dürkopp Adler.

To test inputs and outputs:

1. In the menu item Extras > Service > Multitest tap the 
Eingänge / Ausgänge testen (Test inputs / 
outputs) option.

 The IO-Test (IO Test) Seite (Page) window is 
displayed.

Fig. 53: Testing inputs and outputs

The input elements are listed and selected at the left side (1) and the out-
put elements at the right side (2).

WARNING
Risk of injury from sharp and moving parts!
Puncture or crushing possible.

Do not reach into the machine during function 
testing of inputs and outputs.

(1) - Area for input elements (2) - Area for output elements

① ②
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2. Use Auswahl (Select) + or Auswahl (Select) - to 
select the desired element in the respective area.

 The number of the element is displayed on the ausgewählt: 
(selected:) button.

3. Tap the ausgewählt: (selected:) button.

4. Test the element using the Ein/Aus (On/Off) or 
umschalten (switchover) buttons, depending on the
type of the input or output element.

Input elements

No. Meaning
S1 Lower right clamp
S2 Lower left clamp
S9 Needle thread monitor active
S10 Bobbin cover closed
S11 Upper housing latch closed
S13 Pedal forwards
S14 Pedal backwards
S16 Pressure monitor
S17 Quick stop
S100 Sewing motor reference
S101 X-axis reference
S102 Y-axis reference
S103 Z-axis reference

Output elements

No. Meaning
Y1 Foot mode
Y2 Bobbin cover
Y3 Needle cooling on
Y4 Right clamp
Y5 Left clamp
Y9 Threading switch lamp on
Y10 Oil level indicator warning light on
Y11 Burner transformer on
Y12 Upper burner
Y13 Lower burner
Y14 Thread suction device
Y25 Laser marking lamp 1 (Z)
Y26 Laser marking lamp 2 (Z)
Y27 Laser marking lamp 3 (Z)
Y28 Laser marking lamp 4 (Z)
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Setting the stroke position

To set the stroke position:

1. In the menu item Extras > Service > Multitest tap the 
Hublage einstellen (Set stroke position) option.

 The following options are displayed:

2. Tap the desired symbol and execute the function.

WARNING
Risk of injury from sharp and moving parts!
Puncture or crushing possible.

Do not reach into the machine when setting the 
stroke position.
Switch off the power to the drives when you wish to 
test the freedom of motion of the sewing foot rod.

Setting the stroke position

Symbol Meaning
Perform a reference run
Check the movement

Switch between a hopper and presser foot
Switch over the mode of operation

Move to position
Set the sewing foot height

Switch off the power to the drives
Manually check the freedom of motion of the sewing foot rod
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Test sewing motor

To test the sewing motor:

1. In the menu item Extras > Service > Multitest tap the 
Nähmotor testen (Test sewing motor) option.

 The sewing motor test screen is displayed:

Fig. 54: Test sewing motor

Important
Remove the thread from the needle and needle lever before starting the 
test.

2. Tap the  button.
 The window for entering the sewing speed opens.
3. Enter the desired value (300 - 2000 rpm).

4. Tap the  button.
 The window for entering the cutting speed opens.
5. Enter the desired value (70 - 500 rpm).

6. Tap the  button.
 The sewing motor runs at the entered sewing speed.

WARNING
Risk of injury from sharp and moving parts!
Puncture or crushing possible.

Do not reach into the machine during the function 
test of the sewing motor.
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7. Tap the  button.
 The sewing motor stops.

8. Tap the  button.
 The sewing motor runs at the entered sewing speed.

9. Tap the  button.
 The sewing motor stops and the thread cutter is actuated.

Calling up log displays and error lists
You can access the log settings and error lists via Extras > Service 
> System-Information (System Information).

To call up log displays and error lists:

1. Tap the menu items Extras > Service > 
System-Information (System Information).

 The selection screen for system information appears.

Fig. 55: Calling up log displays and error lists

2. Tap the desired symbol.

Symbol Meaning
Control events
List of the latest errors

Log settings
Only for Dürkopp Adler Service personnel

Log display
List of the last log settings

Control panel status
Status appears in the log display
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Initializing the control and performing updates
You can use Extras > Service > Initialisierung 
(Initialization) and Update to reset the control and control 
panel to the factory defaults and to update the control with a new software 
version.

To initialize the control and perform updates:

1. Tap the menu items Extras > Service > Initialisierung 
(Initialization) and Update.

 The screen for initialization and update appears.

Fig. 56: Initializing the control and performing updates

Initializing the control
Important
Initializing the control resets all values to the factory default settings. 
All changes are lost. 
Only execute this option if you really want to return to the factory settings.

Order
Save your seam programs and sequences to a USB key before perform-
ing initialization.

1. Tap the Initialisierung (Initialize) Steuerung 
(Control) option.

 The control is completely reset to the factory default settings.
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Initializing the control panel
Important
Initializing the control panel resets all values to the factory default settings. 
All changes are lost. 
Only execute this option if you really want to return to the factory settings.

1. Tap the Initialisierung des Bedienfelds 
(Initialize control panel) option.

 The control panel is completely reset to the factory default settings.

Updating the control

Information
The latest software version is available in the download area at
www.duerkopp-adler.com.

You can easily transfer a new software version from a USB key to the con-
trol.

Important
Not all commonly available USB keys are suitable for the copying process.
You can obtain a suitable USB key from Dürkopp Adler using the part 
number 9805 791113.

To perform an update of the control:

1. Switch off the machine.
2. Insert the USB key into the USB port (1) on the operating terminal.

Fig. 57: Updating the control

(1) - USB port (2) - 

①
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3. Switch on the machine.
 The software update is performed automatically.

Information
If the automatic update does not function then you can use the menu items 
Extras > Service > Initialisierung (Initialize) 
and Update > Option Update der (the) Steuerung
(control) to load a specific software version.

Contact the Dürkopp Adler Service Hotline for this.

Displaying software version information
The menu item ? displays information on the software currently installed 
on the machine.

To display information on the software version currently used:

1. Menu items? > Tap on Info.
 The following information is displayed:

• Class
• Subclass
• Software version
• Date of creation of this software version
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6 Creating programs with DA-CAD 5000
You can use the DA-CAD 5000 program to create seam programs on a 
PC. The DA-CAD 5000 program is available as additional equipment.

This section only provides an overview of the program steps. A detailed 
description is provided in the  Operating Instructions for the DA CAD 
5000 program.

Selecting the class
The first step is to select the machine class.

Fig. 58: Selecting the class

Creating the seam contour
The next step is to draw the seam contour.

Fig. 59: Creating the seam contour
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Saving the seam contour

Fig. 60: Saving the seam contour

The final step is to save the finished seam program and copy it to a USB 
key.

Important
Not all commonly available USB keys are suitable for the copying process.
You can obtain a suitable USB key from Dürkopp Adler using the part 
number 9805 791113.

To save a seam contour:

1. Select the menu items Datenübertragung (Data
transfer) > USB-Memorystick (USB memory stick) 
> Speichern (Save) (PC->>USB).

Order
After successfully saving to the USB key the following steps must be 
performed at the machine:
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Transferring the program to the machine

To transfer a program to the machine:

1. Insert the USB key and copy the desired file to the DAC( p. 59).
2. Open the copied program ( p. 44).
3. Adjust the program parameters (especially the sewing foot 

height) ( p. 63).
4. Perform a contour test to check the clamp motion ( p. 55).
 Sewing with the program can begin after successful testing/adjustment.

NOTICE

Property damage may occur!
If you have entered contour points that lie outside the sewing field 
then the movement of the clamps during sewing can cause damage 
to the machine or the sewing material.

Always perform a contour test after creating or editing a contour to 
ensure that the entire contour lies within the permissible sewing field.
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7 Maintenance
This chapter describes maintenance work that needs to be carried out on 
a regular basis to extend the service life of the machine and achieve the 
desired seam quality.

Advanced maintenance work may only be carried out by qualified special-
ists ( Service Instructions).

Maintenance interval

WARNING
Risk of injury from sharp parts!
Punctures and cutting possible.

Prior to any maintenance work, switch off the 
machine or set the machine to threading mode.

WARNING
Risk of injury from moving parts!
Crushing possible.

Prior to any maintenance work, switch off the 
machine or set the machine to threading mode.

Work to be carried out Operating hours

8 40 160 500

Cleaning

Removing lint and thread remnants 

Cleaning the motor fan mesh 

Lubricating

Lubricating the machine head 

Lubricating the hook 

Servicing the pneumatic system

Setting the operating pressure 

Draining the water condensation 

Cleaning the filter element 
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7.1 Cleaning

Servicing specific components

Checking the toothed belt 

WARNING
Risk of injury from flying particles!
Flying particles can enter the eyes, causing injury.

Wear safety goggles.
Hold the compressed air gun so that the particles 
do not fly close to people.
Make sure no particles fly into the oil pan.

NOTICE

Property damage from soiling!
Lint and thread remnants can impair the operation of the machine.

Clean the machine as described.

NOTICE

Property damage from solvent-based cleaners!
Solvent-based cleaners will damage paintwork.

Use only solvent-free substances for cleaning.

Work to be carried out Operating hours

8 40 160 500
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7.1.1 Cleaning the machine
Lint and thread remnants should be removed after every 8 operating hours 
using a compressed air gun or a brush. If very fluffy sewing material is being 
sewn the machine must be cleaned more frequently.

Fig. 61: Cleaning the machine

Areas particularly susceptible to soiling:
• Cutter on the winder for the hook thread (4)
• Area under the throat plate (3)
• Hook (2)
• Area around the needle (1)

To clean the machine:

1. Remove any lint and thread remnants using a compressed air gun or 
a brush.

(1) - Area around the needle
(2) - Hook

(3) - Area under the throat plate
(4) - Cutter on the bobbin winder
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7.1.2 Cleaning the motor fan mesh
The motor fan mesh must be cleaned once a month using a compressed 
air gun. If very fluffy sewing material is being sewn, the motor fan mesh 
must be cleaned more frequently.

Fig. 62: Cleaning the motor fan mesh

To clean the motor fan mesh:

1. Remove any lint and thread remnants using a compressed air gun.

(1) - Motor fan mesh

①
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7.2 Lubricating

The machine is equipped with a central oil-wick lubrication system. 
The bearings are supplied from the oil reservoir.

For topping off the oil reservoir, use only lubricating oil DA 10 or oil of 
equivalent quality with the following specifications:

• Viscosity at 40 °C: 10 mm²/s
• Flash point: 150 °C
You can order the lubricating oil from our sales offices using the following 
part numbers:

CAUTION
Risk of injury from contact with oil!
Oil can cause a rash if it comes into contact with 
skin.

Avoid skin contact with oil.
If oil has come into contact with your skin, wash the 
affected areas thoroughly.

NOTICE

Property damage from incorrect oil!
Incorrect oil types can result in damage to the machine.

Only use oil that complies with the data in the instructions.

CAUTION
Risk of environmental damage from oil!
Oil is a pollutant and must not enter the sewage 
system or the soil.

Carefully collect up used oil.
Dispose of used oil and oily machine parts in 
accordance with national regulations.

Container Part no.

250 ml 9047 000011

1 l 9047 000012

2 l 9047 000013

5 l 9047 000014
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7.2.1 Lubricating the machine head
Proper setting
The oil level is between the minimum level marking and the maximum 
level marking.

Fig. 63: Lubricating the machine head

To lubricate the machine head:

1. Check the oil level indicator every day.
2. If the oil level is below the minimum level marking (3):

Pour oil through the refill opening (1) but no higher than the maximum 
level marking (2).

7.2.2 Lubricating the hook
The approved oil quantity for hook lubrication is a factory specification. 

Proper setting
1. Hold a piece of blotting paper next to the hook (1) while sewing.
 After sewing a stretch of approx. 1 m, the blotting paper will have 

been sprayed with a thin and even film of oil.

Fig. 64: Lubricating the hook

(1) - Refill opening
(2) - Maximum level mark

(3) - Minimum level mark

①

②

③

(1) - Hook (2) - Screw

① ②
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To lubricate the hook:

1. Turn the screw (2):
• counterclockwise: more oil is released
• clockwise: less oil is released

Important
The released amount of oil does not change until the operating time has 
run a few minutes. Sew for several minutes before you check the setting 
again.

7.3 Servicing the pneumatic system

7.3.1 Setting the operating pressure

Proper setting
Refer to the Technical data ( p. 127) chapter for the permissible 
operating pressure. The operating pressure cannot deviate by more than 
± 0.5 bar.

Check the operating pressure on a daily basis.

Fig. 65: Setting the operating pressure

NOTICE

Property damage from incorrect setting!
Incorrect operating pressure can result in damage to the machine.

Ensure that the machine is only used when the operating pressure 
is set correctly.

(1) - Pressure controller (2) - Pressure gage

①

②
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To set the operating pressure:

1. Pull the pressure controller (1) up.
2. Turn the pressure controller until the pressure gage (2) indicates the 

proper setting:
• Increase pressure = turn clockwise
• Reduce pressure = turn counterclockwise

3. Push the pressure controller (1) down.

7.3.2 Draining the water condensation

Water condensation accumulates in the water separator (2) of the pressure 
controller.

Proper setting
Water condensation must not rise up to the level of the filter element (1).

Check the water level in the water separator (2) on a daily basis.

Fig. 66: Draining the water condensation

To drain water condensation:

1. Disconnect the machine from the compressed air supply. 
2. Place the collection tray under the drain screw (3).
3. Loosen the drain screw (3) completely.
4. Allow water to drain into the collection tray.
5. Tighten the drain screw (3).
6. Connect the machine to the compressed air supply.

NOTICE

Property damage from excess water!
Excess water can cause damage to the machine.

Drain water as required.

(1) - Filter element
(2) - Water separator

(3) - Drain screw

①
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7.3.3 Cleaning the filter element

Fig. 67: Cleaning the filter element

To clean the filter element:

1. Disconnect the machine from the compressed air supply.
2. Drain the water condensation ( p. 98).
3. Loosen the water separator (2).
4. Loosen the filter element (1).
5. Blow out the filter element (1) using a compressed air gun.
6. Wash out the filter tray using benzine.
7. Tighten the filter element (1).
8. Tighten the water separator (2).
9. Tighten the drain screw (3).
10. Connect the machine to the compressed air supply.

NOTICE

Damage to the paintwork from solvent-based cleaners!
Solvent-based cleaners damage the filter. 

Use only solvent-free substances for washing out the filter tray.

(1) - Filter element
(2) - Water separator

(3) - Drain screw

①

② ③
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7.4 Servicing specific components

Checking the toothed belt

The condition of the toothed belt must be checked once a month.

Important
A damaged toothed belt must be replaced immediately.

Proper setting
• The toothed belt exhibits no cracks or fragile areas.
• When pressed with a finger, the toothed belt must yield no more than 

10 mm.

7.5 Parts list
A parts list can be ordered from Dürkopp Adler. Or visit our website for 
further information at:

www.duerkopp-adler.com

WARNING
Risk of injury from moving parts!
Crushing possible.

Switch off the machine before checking the 
condition of the toothed belt.
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8 Setup

8.1 Checking the scope of delivery
Important
The scope of delivery depends on your specific order.

1. Check that all parts are present before setup.

WARNING
Risk of injury from cutting parts!
Cutting injuries may be sustained while unpacking 
and setting up the machine.

Only qualified specialists may set up the machine.
Wear safety gloves.

WARNING
Risk of injury from moving parts!
Crushing injuries may be sustained while 
unpacking and setting up the machine.

Only qualified specialists may set up the machine.
Wear safety shoes.
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Fig. 68: Checking the scope of delivery

Scope of delivery:
• Double lockstitch machine (2), equipped with: 

• Automatic sewing foot and clamp lifting
• Stroke position adjustment
• Thread cutter
• Needle thread monitoring
• Threading device
• Multiple thread tensioning

• Compressed air maintenance unit (4)
• Height-adjustable stand (3)
• Reel stand (1)
• Tools and small parts in accessory pack
• Additional equipment (optional)

(1) - Reel stand
(2) - Machine head

(3) - Stand
(4) - Compressed air maintenance unit

④

①

②

③

102 Operating Instructions 911-211 - 05.0 - 08/2019



Setup
8.2 Transporting the machine

Important
While being transported, the machine must always be in transport position 
(high adjustment right at the bottom).

Different stands are provided, depending on the order:

• Stand with own rollers (1)
• Stand without rollers (2)

Fig. 69: Transporting the machine

WARNING
Risk of injury from moving parts!
Crushing possible.

The machine is heavy.
Always use a lifting carriage or forklift for lifting the 
machine to avoid back injuries or crushing injuries 
if the machine falls down.

WARNING
Risk of injury from unsafe positioning of the 
machine.
Crushing possible.

Before commissioning all stand variants ensure 
that the stand feet are turned out sufficiently and 
that the machine stands securely.

(1) - Stand foot with rollers (2) - Stand foot without rollers

① ②
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Stands with own rollers (1) can be used for transporting the machine. 
Stands without rollers must be transported with a lifting carriage or forklift.

Lifting the machine
Use a lifting carriage or forklift when lifting the machine for transport.

Transport on own stand rollers
The stand feet must be rotated upwards for transportation using the inte-
grated stand rollers.

Fig. 70: Transport on own stand rollers

Before transport
1. Loosen the nuts (1) on the stand feet (2).
2. Rotate the stand feet (2) fully upwards.
3. Tighten the nuts (1) so that the stand feet (2) remain upwards.

After transport
1. Loosen the nuts (1) on the stand feet (2).
Important
Rotate the stand feet (2) downwards so that the stand is supported evenly 
and firmly on all four feet.

2. Tighten the nuts (1) on all four stand feet.

(1) - Nut
(2) - Stand foot

(3) - Roller

③①

②
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8.3 Transport locks

The transport locks protect the machine during movement and must be re-
moved before setting up.

1. Remove all transport locks fitted.

Important
The transport locks must be assembled again if the machine is transported 
in the future!

NOTICE

Property damage may occur!
Risk of machine damage from unsecured transport.

NEVER transport the machine without the transport locks.
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8.4 Setting the working height

8.4.1 Setting the working height for stands with rollers
The working height is continuously adjustable between 800 and 1050 mm 
(clearance between the floor and upper edge of the tabletop).

Fig. 71: Setting the working height for stands with rollers

WARNING
Risk of injury from moving parts!
The tabletop can sink under its own weight when 
the screws on the stand bars are loosened. 
Crushing possible.

Ensure that your hands are not jammed when 
releasing the screws.

CAUTION
Risk of musculoskeletal damage from incorrect 
setting!
The operator can sustain musculoskeletal damage 
if failing to comply with the ergonomic 
requirements.

Adjust the working height to the body height of the 
person who will operate the machine.

(1) - Clamping screws

①
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To set the working height for stands with rollers:

1. Support the unit with a lifting carriage or forklift.
2. Loosen all 8 clamping screws (1) on the table legs.
3. Set the tabletop to the desired working height.
Important
Pull out or push in the stand bars evenly at both sides to prevent them from 
jamming.

4. Tighten all 8 clamping screws (1).
5. Remove the lifting carriage or forklift.

8.4.2 Stands without rollers
The working height is continuously adjustable between 760 and 910 mm 
(clearance between the floor and upper edge of the tabletop).

Fig. 72: Setting the working height for stands without rollers

To set the working height for stands without rollers:

1. Support the unit with a lifting carriage or forklift.
2. Loosen all 4 nuts (1) on the table legs.
3. Adjust the tabletop level to the desired working height by turning the 

threaded rods (2).
Important
Turn the threaded rods (2) evenly at both sides to prevent jamming.

4. Tighten all 4 nuts (1).
5. Remove the lifting carriage or forklift.

(1) - Threaded rod (2) - Nut

②

①
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8.4.3 Setting the working height for stands with electric height 
adjustment (300 x 200)

Fig. 73: Setting the working height for stands with electric height adjustment

To set the working height for stands with electric height adjustment:

1. Push the height adjustment switch (1) up.
 Tabletop is raised.
2. Push the height adjustment switch (1) down.
 Tabletop is lowered.

8.5 Pedal setup
The pedal can be freely positioned in front of the machine as far as the ca-
ble allows.

Fig. 74: Pedal setup

(1) - Height adjustment switch

①

(1) - Pedal

①
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To set up the pedal:

1. Position the pedal (1) under the machine so that pedal and machine 
can be comfortably operated.

Different positioning of the pedal
If the pedal is positioned in front of the unit, a tunnel-type cover has to be 
attached over the pedal. The cover protects against spontaneous start-up 
of the machine due to falling objects.

8.6 Assembling the reel stand

Fig. 75: Assembling the reel stand

To assemble the reel stand:

1. Insert the reel stand (1) into the hole in the tabletop.
2. Assemble the reel stand (1) to the tabletop using the nuts (4).
3. Screw the thread plate (3) and the thread guide (2) onto the reel stand 

in such a way that they are located precisely above one another.

(1) - Reel stand
(2) - Thread guide

(3) - Thread reel holder
(4) - Nuts

①

①

②

③

④
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8.7 Electrical connection

8.7.1 Checking the rated voltage
To check the rated voltage:

1. Check the mains voltage before connecting the machine.

8.7.2 Connecting the mains power
To connect the mains power:

1. Connect the mains plug: 230V - 50/60 Hz

8.8 Pneumatic connection
The pneumatic system of the machine and of the additional equipment 
must be supplied with dry and oil-free compressed air. The supply pres-
sure must lie between 8 and 10 bar.

DANGER
Risk of death from live components!
Unprotected contact with electricity can result in 
serious injuries or death.

Only qualified specialists may perform work on 
electrical equipment.

NOTICE

Property damage from oily compressed air!
Oil particles in the compressed air can cause malfunctions of the 
machine and soil the sewing material.

Ensure that no oil particles enter the compressed air supply.

NOTICE

Property damage from incorrect setting!
Incorrect system pressure can result in damage to the machine.

Ensure that the machine is only used when the system pressure is 
set correctly.
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8.8.1 Assembling the compressed air maintenance unit

Fig. 76: Assembling the compressed air maintenance unit

To assemble the compressed air maintenance unit:

1. Connect the connection hose (3) to the compressed air supply using 
a hose coupling R 1/4”.

(1) - Pressure controller
(2) - Pressure gage

(3) - Connection hose

①

②

③

Operating Instructions 911-211 - 05.0 - 08/2019 111



Setup
8.8.2 Setting the operating pressure

Proper setting
Refer to the Technical data ( p. 127) chapter for the permissible 
operating pressure. The operating pressure cannot deviate by more than 
± 0.5 bar.

Fig. 77: Setting the operating pressure

To set the operating pressure:

1. Pull the pressure controller (1) up.
2. Turn the pressure controller until the pressure gage (2) indicates the 

proper setting:
• Increase pressure = turn clockwise
• Reduce pressure = turn counterclockwise

3. Push the pressure controller (1) down.

NOTICE

Property damage due to incorrect operating pressure!
Incorrect operating pressure can result in damage to the machine.

Ensure that the machine is only used when the operating pressure 
is set correctly.

(1) - Pressure controller (2) - Pressure gage

①

②
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8.9 Commissioning
Carry out a sewing test before starting up the machine. 
Adjust the machine to the sewing material requirements.
To do so, read the corresponding chapters in the  Operating Instruc-
tions. Read the corresponding chapters in the  Service Instructions in 
order to make adjustments to the machine if the sewing results do not con-
form to the requirements.

Performing a sewing test
1. Switch off the machine at the main switch.
2. Thread the needle thread ( p. 22).
3. Thread the hook thread ( p. 27).
4. Switch on the machine at the main switch.
 The control is initialized.
5. Press the pedal forwards.
 The reference run starts.

The transport carriage moves to the reference position.

Information
The reference run is necessary in order to obtain a defined starting posi-
tion of the transport carriage.
Pressing the pedal forwards triggers the different steps of the insertion 
procedure one after another and then starts the sewing process.

WARNING
Risk of injury from sharp and moving parts!
Puncture or crushing possible.

Turn off the machine before changing the needle, 
threading threads, inserting the bobbin, setting the 
hook thread tension or setting the needle thread 
regulator.

NOTICE

Property damage may occur!
Risk of machine damage from transport without sewing material.

Ensure that sewing material is present under the transport clamps 
before starting to sew.
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9 Decommissioning
You need to perform a number of activities if the machine is to be shut 
down for a longer period of time or completely decommissioned.

To decommission the machine:

1. Switch off the machine.
2. Unplug the power plug.
3. If applicable, disconnect the machine from the compressed air supply.
4. Remove residual oil from the oil pan using a cloth.
5. Cover the control panel to protect it from soiling.
6. Cover the control to protect it from soiling.
7. Cover the entire machine if possible to protect it from contamination 

and damage.

WARNING
Risk of injury from a lack of care!
Serious injuries may occur.

ONLY clean the machine when it is switched off.
Allow ONLY trained personnel to disconnect the 
machine.

CAUTION
Risk of injury from contact with oil!
Oil can cause a rash if it comes into contact with 
skin.

Avoid skin contact with oil.
If oil has come into contact with your skin, wash the 
affected areas thoroughly.
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10 Disposal
The machine must not be disposed of in the normal household waste.

The machine must be disposed of in a suitable and proper manner and in 
accordance with all applicable national regulations.

When disposing of the machine, be aware that it consists of a range of dif-
ferent materials (steel, plastic, electronic components, etc.). Follow the 
applicable national regulations when disposing of these materials.

CAUTION
Risk of environmental damage from improper
disposal!
Improper disposal of the machine can result in 
serious environmental damage.

ALWAYS comply with the legal regulations 
regarding disposal.
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11 Troubleshooting

11.1 Customer Service
Contact for repairs and issues with the machine:

Dürkopp Adler AG
Potsdamer Str. 190
33719 Bielefeld, Germany

Tel. +49 (0) 180 5 383 756
Fax +49 (0) 521 925 2594
Email: service@duerkopp-adler.com
Internet: www.duerkopp-adler.comError and information messages
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11.2 Messages of the software

Error 
code Description Troubleshooting

Sewing motor

1051 Sewing motor timeout
• Cable to sewing motor reference

switch defective
• Reference switch defective
• Machine head does not move freely 

or has excessive belt tension

• Replace the cable

• Replace the reference switch
• Check the ease of movement and 

belt tension of the machine head

1052 Sewing motor excess current
• Sewing motor cable defective
• Sewing motor defective
• Control defective

• Replace the sewing motor cable
• Replace the sewing motor
• Replace the control

1053 Sewing motor line voltage too high Check the line voltage

1055 Sewing motor overload
• Sewing motor blocked/not moving 

freely
• Sewing motor defective
• Control defective

• Remove the blockage/cause of lack 
of freedom of movement

• Check the sewing motor
• Check the control

1056 Sewing motor overtemperature
• Sewing motor not moving freely
• Sewing motor defective
• Control defective

• Eliminate seizing
• Replace the sewing motor
• Replace the control

1058
1302
1342

1344 

Sewing motor speed
• Sewing motor defective
Sewing motor error
Control not receiving pulses from 
pulse encoder in motor
Sewing motor error
Internal error 

• Replace the sewing motor
• Check the cable from the impulse 

transmitter in the motor to the 
control

• Switch off and on the machine 
again

• Software update

Stepper motors

2101 X-axis stepper motor referencing 
timeout
• Faulty reference switch setting
• Faulty cable to the reference switch
• Reference switch defective

• Adjust reference switch
• Replace the cable
• Check the reference switch

2102 X-axis stepper motor current error
• Stepper motor blocked
• Encoder cable not connected or 

defective
• Encoder defective

• Fix blockage
• Check/replace the encoder cable
• Replace the stepper motor

2152 X-axis stepper motor overcurrent • Replace the stepper motor
• Replace the control

2153 X-axis stepper motor overvoltage
• Too high line voltage

• Check the line voltage

2155 X-axis stepper motor overload
• Feed system not moving freely
• Obstacle to feed motion

• Eliminate sluggishness
• Remove obstacles/adjust the motion
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Troubleshooting
2156 X-axis stepper motor excess 
temperature
• Stepper motor sluggish
• Stepper motor faulty
• Control defective

• Eliminate seizing
• Replace the stepper motor
• Replace the control

2201 Y-axis stepper motor referencing 
timeout
• Faulty reference switch setting
• Faulty cable to the reference switch
• Reference switch defective

• Adjust reference switch
• Replace the cable
• Replace the reference switch

2202 Y-axis stepper motor current error
• Stepper motor blocked
• Encoder cable not connected or 

defective
• Encoder defective

• Fix blockage
• Check/replace the encoder cable

• Replace the encoder

2252 Y-axis stepper motor overcurrent • Replace the stepper motor
• Replace the control

2253 Y-axis stepper motor overvoltage
• Too high line voltage • Check the line voltage

2255 Y-axis stepper motor overload
• Feed system not moving freely
• Obstacles to the feed motion

• Eliminate sluggishness
• Remove obstacles/adjust the motion

2256 Y-axis stepper motor overtemperature
• Feed system not moving freely
• Stepper motor faulty
• Control defective

• Eliminate seizing
• Replace the stepper motor
• Replace the control

2301 Stroke position stepper motor 
referencing timeout
• Faulty reference switch setting
• Faulty cable to the reference switch
• Reference switch defective 

• Adjust reference switch
• Replace the cable
• Replace the reference switch

2302 Stroke position stepper motor current 
error
• Stepper motor blocked
• Encoder cable not connected or 

defective
• Encoder defective

• Fix blockage
• Check/replace the encoder cable

• Replace the encoder

2352 Stroke position stepper motor 
overcurrent

• Replace the stepper motor
• Replace the control

2353 Stroke position stepper motor 
overvoltage
• Too high line voltage • Check the line voltage

2355 Stroke position step motor overload
• Feed system not moving freely
• Obstacles to the feed motion

• Eliminate sluggishness
• Remove obstacles/adjust the motion

Error 
code Description Troubleshooting
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Troubleshooting
2356 Stroke position stepper motor 
overtemperature
• Feed system not moving freely
• Stepper motor faulty
• Control defective

• Eliminate sluggishness
• Replace the stepper motor
• Replace the control

Machine control

3100 Machine control voltage 
• Temporary line voltage interruption • Check the line voltage

3102 Machine voltage in sewing motor 
intermediate circuit 
• Temporary line voltage interruption • Check the line voltage

3103 Machine voltage in stepper motor 
intermediate circuit 
• Temporary line voltage interruption • Check the line voltage

3107 Machine temperature 
• Ventilation openings closed
• Ventilation grille dirty

• Clean ventilation grille
• Check ventilation openings

3109 Threading mode is switched on Switch off threading mode

3121 Compressed air is missing or 
insufficient

Turn on the compressed air, stabilize

3123 Oil sensor active Top off oil

3210 Thread broken Re-thread the thread

3215 Bobbin empty (remaining thread 
counter)

Insert full bobbin

3220 Bobbin empty (remaining thread 
counter)

Insert full bobbin

3500 Error in calculating the contour data • Reload the contour data
• Check the contour data

3501 Target position of the XY clamps 
outside the motion limits 

Adjust the contour data

3502 Target position of the XY clamps within 
the "forbidden areas"

Adjust the contour data

3721
3722 

Internal error • Switch off and on the machine
• Software update
• Notify DA Service

4201 Internal CF card defective • Switch off and on the machine
• Retrofit/replace control

5301 Program cannot be sewn Copy program to DAC

Error 
code Description Troubleshooting
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6551

6554
6651

6653
6751

6761

Error in machine head position/AD 
converter/process error

Internal error

• Switch off and on the machine
• Software update

• Notify DA Service

6952 Stepper motor driver error
Internal error

• Switch off and on the machine
• Software update
• Notify DA Service

Communication

7801 Control panel interface communication
• Cable disturbance
• Cable 

• Switch off and on the machine
• Software update
• Notify DA Service

8151
8156

8159

IDMA error
• Disturbance
• Control defective

• Switch off and on the machine
• Replace the control

 8152

8154

IDMA error
• Internal error

• Switch off and on the machine
• Software update
• Notify DA Service

8252
8257
8258

8256
8254

ADSP Boot/Xilinx Boot/ Boot error
Disturbance

• Switch off and on the machine

8351 Test pins error • Switch off and on the machine
• Software update
• Notify DA Service

9601 Stop while sewing on the contour
Continue sewing?

• OK button = 
Continue the sewing process

• ESC button = 
Interrupt the sewing process

9700 Bobbin change flap not closed Close the bobbin change flap

9701 Parallel clamps not lowered • Remove obstacles
• Adjust sensors

9900 Incorrect machine parameter Initialize the data

9901 Incorrect sequences Initialize the data

9902 Incorrect program parameters Initialize the data

Error 
code Description Troubleshooting
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11.3 Information messages

Information 
code Description Troubleshooting

8400 Control panel has no valid 
program for the DAC.

Load the current program into the 
control panel from a USB key.

8401
8402

Control panel has no valid 
program for the DAC.

Load the current program into the 
control panel from a USB key.

8403 Program in DAC is no longer 
current.

Load the current program into the 
DAC.

8404

8407

DAC update failed. • Attempt the update again
• Check cable connections
• Replace the DAC

8408 Waiting for a DAC reset. Wait until the restart has been 
performed 
(Duration: several seconds).

8411 DAC program check is active. Wait until the test has been 
performed (Duration: several 
seconds).

8414 DAC update succeeded.

8801

8805
8806
8890
8891

Error in test pins/signal 
processing/event processing/
Memory wrapper/
list functions
Internal error

• Switch off and on the machine
• Software update
• Notify DA Service

System

9000 Reference run active

9002 Machine head not locked Lock the machine head

9006 Quick-stop button is active. Release the Quick-stop button

9016 Incorrect barcode ID Change the program

9100 The counter has not reached the 
specified value.

Tap the OK button. The counter is 
reset.
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11.4 Errors in sewing process

Error Possible causes Remedial action

Unthreading at seam 
beginning

Needle thread tension is 
too firm

Check needle thread tension

Thread breaking Needle thread and hook 
thread have not been 
threaded correctly

Check threading path

Needle is bent or
sharp-edged

Replace the needle

Needle is not inserted 
correctly into the needle 
bar

Insert the needle correctly into the 
needle bar

The thread used is 
unsuitable

Use recommended thread

Thread tensions are too 
tight for the thread used

Check thread tensions

Thread-guiding parts, such 
as thread tube, thread 
guide or thread take-up 
disk, are sharp-edged

Check threading path

Throat plate, hook or 
spread have been 
damaged by the needle

Have parts reworked by qualified 
specialists

Missing stitches Needle thread and hook 
thread have not been 
threaded correctly

Check threading path

Needle is blunt or bent Replace the needle

Needle is not inserted 
correctly into the needle 
bar

Insert the needle correctly into the 
needle bar

The needle thickness used 
is unsuitable

Use recommended needle 
thickness

The thread reel holder is 
installed incorrectly

Check the assembly of the thread 
reel holder

Thread tensions are too 
tight

Check thread tensions

Throat plate, hook or 
spread have been 
damaged by the needle

Have parts reworked by qualified 
specialists
Operating Instructions 911-211 - 05.0 - 08/2019 125



Troubleshooting
Loose stitches Thread tensions are not 
adjusted to the sewing 
material, the sewing 
material thickness or the 
thread used

Check thread tensions

Needle thread and hook 
thread have not been 
threaded correctly

Check threading path

Needle breakage Needle thickness is 
unsuitable for the sewing 
material or the thread

Use recommended needle 
thickness

Error Possible causes Remedial action
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Technical data
12 Technical data

Data and characteristic values

Characteristics
The machine is driven by a positioning drive. 

In addition to the sewing drive, the DACIII control controls two stepper mo-
tors for the X and Y motion for creating the seam geometry and a Z axis 
for sewing foot adjustment. 

The arm shaft of the sewing machine is directly driven by a brushless DC 
motor 

Intermittent up to 1400 rpm (depending on stitch length and sewing mate-
rial thickness) 

Maximum speed also varies with the application as well as clamp size and 
clamp weight 

Available are 99 program memory slots with up to 16000 stitches each 

Technical data Unit

91
1-

21
1-

20
10

91
1-

21
1-

30
20

Machine type CNC-controlled sewing unit

Stitch type 301

Hook type Vertical hook

Number of needles 1

Needle system 794, on request 7x23

Needle strength [Nm] 140-230

Thread strength [Nm] Min: 20/3
Max: 8/3

Stitch length [mm] Programmable 1-12.7

Speed maximum [min-1] 1400 rpm, intermittent

Mains voltage [V] 230

Mains frequency [Hz] 50/60

Operating pressure [bar] 6

Length [mm] 940 940

Width [mm] 1100 1200

Weight [kg] Approx. 230
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Technical data
The programs can be sewn individually or as sequences. It is possible to 
store up to 20 sequences capable of calling up a maximum of 30 programs 
each. 

The sewing foot is lifted by motor power. 

Clamps open and close pneumatically. 

The size of the sewing field on the UKL 911 - 211 - 2010 is 200mm and 
100mm in X and Y direction, respectively. 

Lubrication to machine head and hook is provided by a central oil wick 
lubrication system. 

Fitted with a vertical 3XL hook. Diameter 40 mm; CTB bobbin. 

The machine is operated via the graphic control panel OP 7000. 

Including electronic needle thread monitor. 

To create a neat seam pattern, the machine is equipped with a program-
mable needle thread tensioner that can be used to assign different thread 
extraction directions a matching tension value that is stored in the seam 
program. 

The thread drawing device makes it possible to draw the needle thread un-
der the sewing material prior to the first stitch 

The unit also comes with a programmable stitch counter designed to mon-
itor the hook thread and with a piece counter. 

An electronic remaining thread monitor is available as optional equipment. 

Integrated test program for servicing and maintenance work. Aside from 
monitoring the sewing process, the program allows for testing the motor 
functions, the inputs and outputs for reference switches, the valves and 
transport motors, and the RAM memory and (Flash) program memory 
functions. The program is also used to set machine functions and create 
seam programs via a teach-in procedure. 

Individual stitch parameters per stitch for controlling such external units as 
the stroke position of the foot, thread clamp, and thread cutter: Remaining 
thread length 15 mm (H867); a thread burner is available as optional 
equipment. 
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Appendix
13 Appendix

13.1 Wiring diagram - thread burner
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13.2 Wiring diagram - remaining thread monitor
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